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1 System Requirements  

• Internet connection: Internet access is highly recommended. There are several links from the program 

to the web. Financial analysis for U.S. locations uses a web service. The program is updated via the 

Internet.  

• System clock frequency (Processor): 1 GHz  

• RAM: 1 GB 

• Free hard disk space: 700 MB 

• Screen resolution: min. 1.024 x 768 pixels 

• Operating systems: Windows XP, Windows Vista, Windows 7, each with latest Service Packs 

• Graphics: 3D, DirectX– compatible, 128 MB, OpenGL Version 1.1 (for Photoplan) , printer driver 

• Software: DirectX, Version 9.0c; .NET-Framework*, Version 4.0 (Full), Microsoft Installer 4.5 

User rights 

In order to run the program you must have full access (administrator rights) to its installation directory. 

Internet connection 

The program checks the Windows system settings for the proxy settings being used, and uses these to 

establish an Internet connection to the Valentin Software server. The company proxy is also used if 

available. 

If the program is nevertheless still unable to establish an Internet connection, it displays the "No Internet 

connection" message.  In such cases, have your network administrator contact us. 

Country Settings: currency, numbers, time and date  

The program adopts the formats for currency, numbers, time and date set in the country settings of 

Windows' control panel. These formats also appear on print-outs. Please note that the thousands separator 

and the decimal point are different. 

  

* The .NET framework is installed automatically, if not present. 
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2 Program Registration 

You can change the status of the program from demo version to full version by registering. 

• To do this, click on the Register Full Version button when the program starts. 

• To register the program, you require a serial number , obtained by purchasing the program. You can buy 

the program in our online shop or by using our order form . 

• Activate the program by using a key code you receive in the course of the registration. 

Change the registration in the menu Help > Info > Registration. 

Serial Number 

If you have purchased the program, you will have a serial number.  

This is made up of a combination of 38 digits and letters, which you will have to enter without any spaces in 

between, but including the special characters (hyphens). 

You will find the serial number either on the CD case or on the invoice. Alternatively, if you made your 

purchase online, you will have been notified by e-mail. 

Program ID 

The program ID is allocated specifically for your computer and is only valid for use on your computer. A valid 

serial number, issued on purchase of the program, is required to obtain an ID. 

The program ID is automatically provided as soon as you enter the serial number. 

It is not possible to enter the program ID yourself. 

You will need to let us know the program ID when registering, so that we can send you your key code. 

2.1 Activation Key Code 
You can activate your program in two different ways.  

Request a Key Code Online 

This method requires that your computer has internet access. 

Click on the Online button to open a form, where you can enter all the information required to receive a key 

code. The fields marked with an * must be completed. 

After you have completed the form, you can send it straight off – the recipient’s e-mail address is entered 

automatically for your convenience. After sending the e-mail, you will receive your key code, which will be 

sent to the e-mail address you have entered, in approximately 20 minutes. 

Request a Key Code by Telephone 

If you do not have a fax or e-mail, you can request the key code by phone. In this case, you will need to give 

us your program ID when you call. 

Enter the Activation Key Code 

Once you have completed registration, you will receive your key code within the following period: 

• Approx. 20 minutes after online registration 

• 1 working day after registration via phone. 
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You can close the program in the meantime. When you go back into the program to continue registration, the 

entries you have made so far have been saved. 

Once you have received the key code following Registration, enter the key code into the key code input field. 

Click the OK button. You will receive a message, confirming that your program has been activated. 

You can now start working with the full program without having to start up again. 

We are pleased to support your work and wish you every success! 

2.2 Maintenance agreement 
To make sure that you always work with the latest version of our programs and have the latest component 

data available, we recommend that you take advantage of our Software Maintenance Agreement 

The software maintenance covers: 

• The electronic delivery of updates, i.e. program changes within a program level of the software program 

to a higher version of the program, where delivery is made by activation: the provider makes the 

updates available in a network and notifies the customer of the serial number required for activation. 

• The access to new component data via internet, i.e. updated databanks for the software program, e.g. 

PV modules or inverters. 

• Responding to general questions regarding delivery, serial numbers and activation of the software 

program/s and updates, as well as the ability to access component data. 

2.3 Licensing Terms and Provisions 

How many times can the program be installed? 

The number of permissible installations corresponds to the number of licenses you have purchased. If, for 

example, you have purchased a single-user license, you may install the program on one workstation. 

In addition, you can activate the program on a second computer, e.g. a laptop. However, this is only possible 

on the condition that the two installations are not used simultaneously. 

If you need to reactivate the software because you have modified your hardware and therefore reinstalled 

the program, you can submit a reactivation request by using a pre-prepared form, which you find on our web 

site http://www.valentin.de/en/downloads/order-forms or http://valentin-software.com/xcartgold/order-

forms.html in the U.S., respectively. 

Licensing Provisions 
Menu Help > Info ... > Program Info > View License 

The license is displayed as .pdf file. 
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3 Introduction & Quick Guide 

PV*SOL basic is a simulation program for easy and quick design and economic efficiency forecast of grid- 

connected photovoltaic systems. 

PV*SOL basic is meant for technical sales people and installers who need a reliable tool to design accurately 

a simple PV system in the shortest time.  

Program Highlights 

Easy configuration 

• Automatic determination of the best inverter configuration 

• Manual adaptation of the configuration sophisticatedly supported 

Entering the PV module areas in various ways 

• Determination of the number of modules and visualization of the module surface using a photo of the 

house 

• Automatic module mounting on any roof type which can be defined in a graphical 2D roof view 

• Simple parametrization of the module surface 

Optimal evaluation and presentation of results: 

• Yield simulation of grid- connected PV systems by the hour 

• Detailed economic forecast including main parameters like yield payback time net present value 

• Configurable project documentation printout including title page overview page with all main data and 

results data sheets a.s.f (.pdf export) 

Always up to date 

• Regularly updated databases (PV modules inverters) 

• Releases available regularly via program Internet update 

Optimal user support 

• The wizard is constructed with just a few clearly structured data. A clear structure of the input 

parameters allows the rapid completion of the project. Detailed settings are still possible in sub-

dialogs. 

• Any dimensioning errors are avoided by entry verification 

• Extensive help, printable .pdf manual 

• Easy selection of products (PV modules, inverters) are possible via favorites. The user can thus specify 

its range, and use this as a pre-selection. 

• The databases are clearly organized by company. A quick search feature and editing of the columns 

displayed facilitates the selection. 

More Highlights 

• Planning of PV systems using power consumption and surplus feed  

• Calculation of AC losses DC losses and string losses 
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• Climate data selection using zip code or map 

• Extensive project data entry possible 

• The program is available in five languages (German, English, French, Spanish, Italian)  
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3.1 QUICK GUIDE 

Go through all of the toolbar dialogs from left to right. Either click on the Continue arrow  at the left or use 

the symbols. 

Error messages warnings and notes are shown in the Message window below. 

On the right side an overview of the current entries is shown 

Quick Guide 

The following working steps will guide you to your system: 

1.   Project data: Define the project data . 

2. System type and environment : Use the location to select the climate data, define the AC Grid 

and select a system type:  

- Grid-connected PV system - full supply  

- (Only in den USA.: Grid-connected PV system - web-based determination of subsidies and financial 

analysis)  

- Grid-connected PV system - Excess supply and own consumption 

3. Consumption: Define the consumption of your system . 

4.   PV modules: Select a module. Cover your roof area or preset the number of modules directly. 

5.   Inverters: Let the program calculate an optimum system configuration or enter a system 

configuration directly. 

6.   Cable : Define the string, AC, and DC cabling. 

7. Financial Analysis : Check the profitability of your PV system.  

8. Simulation : The simulation of the PV system is performed. 

9.   Results: All results are displayed graphically and can be printed or exported in .pdf format.  

-> See also: Introduction 
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3.2 Demo Version 
The Demo version of this program has the following restrictions 

• No Save / Save as /Save as Template 

• No Open project / Open template 

• Only a few locations  

• The PV module data can only be changed in the module "Example". 

• Database entries cannot be changed. 

• No new data sets can be created. 

• The project report can be displayed but not saved, sent or printed 

• The footer always includes "Demo Version" 

3.3 Messages 
An area for messages is located at the bottom of the main program window.  

There are four categories of messages:  

 Information: offers you tips and help for the optimal design of your project. 

 Warnings: 
occur when data in your project are inconsistent or the program experiences 

unexpected events. 

 No 

simulation: 

your entered data contain errors, and no simulation can be started. This means that 

you can no longer open the Results page. 

 Error: your entry is incorrect. You can only leave this page when the entry has been corrected. 

3.4 Bases of calculation 
This chapter contains information on the bases of calculation. 

3.4.1 Irradiation processor 

In the supplied climate files, radiation to the horizontal plane is given in watts per square meter of active 

solar surface (radiation to the horizontal plane). The program converts this to the tilted surface during the 

simulation in the irradiation processor and multiplies it by the total active solar surface. Possible shading 

reduces the irradiation. 

The irradiation processor must split the radiation into diffuse and direct radiation. The splitting is carried out 

according to Reindl's irradiation model with reduced correlation. [Reindl, D.T.; Beckmann, W. A.; Duffie, J.A. : 

Diffuse fraction correlations; Solar Energy; Vol. 45; No. 1, S.1.7; Pergamon Press; 1990] 

When converting the irradiation onto the tilted surface, the anisotropic sky model by Hay and Davis is used. 

[Duffie,J.A.; Beckmann, W.A.: Solar engineering of thermal process; John Wiley & Sons, USA; second edition; 

1991] This model takes into account an anisotropy factor for circumsolar radiation and ground reflection 

factor entered in the program (Albedo) of 20% (average value for grass, fields, light roofs, roads, etc.) . 
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To convert the direct share of solar radiation in relation to the PV array, taking into account the active solar 

surface from the direct solar radiation to the horizontal plane, the position of the sun relative to the PV area 

must be calculated from the height of the sun, solar azimuth, PV array tilt angle and PV array orientation. 

The height of the sun and the solar azimuth are determined on the basis of the date, time and latitude. The 

tilt angle and azimuth of the PV array are entered in the program. 

The radiation without shading results from the direct and diffuse share together. 

The radiation to tilted PV array surfaces takes into account possible shading of the array.  

The radiation to tilted PV array surfaces is reflected at the module surface. The direct radiation share is 

reflected depending on the position of the sun and the incident angle modifier of the module. The resulting 

radiation is the radiation minus reflection. 

3.4.2 Power Output of PV Module 

By specifying the module voltage, the power output of the PV module can be determined from the irradiation 

to the tilted PV array surface (without reflection losses) and the calculated module temperature. 

Image 1 shows the module output of a typical 100 W module with a module temperature of 25 °C for various 

irradiation levels. The top curve shows the module output under standard test conditions (STC1). It can be 

seen that the module supplies its maximum output of 100 W with a voltage of c. 17 V. This working point of 

the module is called the Maximal Power Point (MPP). It must be determined for all irradiation levels and 

module temperatures. 

 

Image: 1 Output curves for a 100 W module with various irradiation levels 

One requirement of a PV system is that for a given irradiation and module temperature the module voltage is 

regulated so that the modules work at the MPP. This task falls to the inverter. 

On the assumption that the modules are operated in MPP operation, PV*SOL® determines the power output 

of the PV module from the power output of the module under standard test conditions and the efficiency 

characteristic curve of the module. The efficiency characteristic curves are generated from the data on part 

load operation. 

Image 2 shows the typical course of module efficiency at various temperatures. 
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Image 2 Module efficiency at various module temperatures 

The temperature dependency of the curve is determined from the characteristic curve at 25 °C (ηPV, 

MPP(G,TModule=25 °C)) and the output temperature coefficient dηηdT: 

 

If the MPP of the module cannot be maintained, the working point of the module must be calculated from the 

UI characteristic curve field (see image 3). 

 

Image 3 UI characteristic curve field 

The efficiency of the modules also takes into account the following losses: 

• due to deviation from standard spectrum AM 1.5, 

• due to mismatch or reduced yield as a result of deviation from manufacturer information and 

• in diodes. 

These output losses are deducted percentagewise from the module output. In addition, the reflection losses 

at the module surface must be evaluated as module losses. 
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1 Standard test conditions: 1000 W/m² vertical radiation, 25 °C module temperature and radiation spectrum 

AM 1.5 Module output at STC Maximal power point (MPP) Efficiency characteristic curves 

3.4.3 Inverter 

The inverter has two functions. On the one hand, the DC generation of the PV modules is transformed to the 

voltage and frequency of the public power grid in the inverter. On the other, the integrated MPP tracker 

ensures that the PV array is operated at the Maximum Power Point (MPP). 

Conversion to DC and AC is lossy. Via the efficiency characteristic curve, PV*SOL® calculates the output 

power depending on the input power. 

Image 4 shows the typical course of a relative efficiency level. The output power PAC  of the inverter is 

determined as: 

 

PDC = DC Power of the PV modules 

ηηNenn = Efficiency Level at Output power 

ηηrel = relative Efficiency Level 

In order to simulate the MPP tracking of the inverter, the program checks at every calculation step whether 

the module MPP voltage can be set by the inverter. 

If the MPP voltage is outside the MPP tracking range of the inverter, or if several arrays are connected to one 

inverter with different MPP voltages, the controller lowers the UI characteristics of the modules until the 

working point has been found at which the maximum output can be obtained from the PV array. 

 

Image 4 Relative efficiency level of an inverter 

In addition to the efficiency characteristic curve of the inverter, PV*SOL® takes into account the MPP 

matching efficiencies, the stand-by and night-time consumption and the input power threshold beyond 

which the inverter supplies power. All factors are taken into account in the performance ratio. 

3.4.4 Temperature Model 

The temperature of a PV module is of great significance when calculating the power output. An increase of 10 

°C results in a power loss of around 5 %. 
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To determine the module temperature , a linear temperature model dependent on outside temperature and 

irradiation is automatically selected. 

Linear Temperature Model 

In this model, the module temperature has a linear dependence on the irradiation G according to: 

The value of the constant k depends upon the type of module setup and a parameter for the maximum 

achievable heating at maximum irradiation (GSTC = 1000 W/m2) compared with the outdoor temperature Ta: 

• Free-standing installation: k = 20°C. 

• Roof integration, rear ventilation: k = 30°C. 

• Roof or facade integration, no rear ventilation: k = 45°C. 

3.4.5 Cabling Losses 

In order to calculate cabling losses, the cable resistance R is first calculated from the cable cross-section A, 

the cable length I and the specific resistance of the material: 

 

For copper, the specific resistance σ = 0.0175 Ω*mm²/ m. 

 

With 

 

Based on the output, the following applies for the relative dissipation: 

 

3.4.6 Evaluation Parameters 

The input data to define the evaluation parameters are as follows: 

Ein = energy irradiated to the PV array surface 

EPVuse= solar energy generated (AC side) - inverter power consumption 

ELast = electricity requirement of power consumer 

Pnom = installed PV array output 

ηSTC = efficiency of module at STC2 

3.4.7 Financial Analysis 

The financial analysis in PV*SOL basic , according to the net present value method, is based on the following 

formulae: 
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The cash value (BW) of a price-dynamic payment sequence Z, Z*r, Z*r² ... over T years (lifetime) as per VDI 

6025 is: 

  

Cash value (CV) = Z * b(T,q,r) 

b: Cash Value factor  

q: Simple Interest factor (e.g. 1.08 at 8 % simple interest) 

r: Price Change factor (e.g. 1.1 at 10 % price change) 

  

The following applies for the net present value: 

Net present value of the total investment = Σ [CV of the price-dynamic payment sequences over the lifetime] - 

investment + subsidies 

Positive net present values indicate an investment which can be assessed as economically positive. The pay-

back time is the period the system must operate for the investment to yield a net present cash value of the 

overall investment of zero. Pay-back times of over 30 years are not supported. 

If the cash value of the costs is converted into a constant sequence of payment (r=1), then the following 

applies to this sequence Z: 

Z = [CV of costs] * a(q,T)  with  a(q,T): Annuity factor ( = 1 / b(T,q,r) for r=1) 

  

The following applies for the electricity production costs: 

[Electricity production costs] = [annual costs Z] / [annual electricity generation] 
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4 Menus 

Additional functions and options for managing and editing projects can be found in the menus and sub-

menus. 

4.1 File 
Menu File 

In File Management, you can start new projects, open projects, save, export, and exit the program.  

• By clicking New Project, you can either work using the program's default values or begin the project 

with self-defined defaults. Here, it is a good idea to save frequent entries, such as a PV module, in a 

template and start new projects with this template. 

• By clicking Open you can choose whether to edit a project or a template 

• By clicking Import from PV*express 3.0, you can import projects from this program. 

• By clicking Save, you can choose whether you wish to save a project or a template. 

• By clicking Save as, you can save your project file under a new name and/or outside the default 

directory. 

-> See also:  

• Regional Settings: Defaults for new projects:  System of units, Country, Location, Climate 

• Registers: Default setting for the default folder  

4.2 Databases 
Menu Databases 

In the Databases menu, you can manage the following databases: 

• From Grid Tariff, To Grid Tariff, Load Profiles 

• PV Module*, Inverters* 

Databases are edited, selected and grouped in the respective database selection dialog 

To share the database with other users of this program, please use the Import  or Export Database with the 

export format *.sdf. 

If you have access to the internet, you can update your databases. The update is started via Help > Check for 

Updates, and is executed automatically. Data records you have created yourself are not overwritten by this. 

  

*Additionally: The data in the component databases are made directly available by the manufacturers.  

-> See also: 

Reset Database 

  

4.2.1 Defining load profiles 
Menu Databases > Load Profiles 

You can create load profiles yourself and modify them. 
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1. Go to the menu Databases > Load Profiles to open the Electricity Load Profile dialog. Here, you can 

open load profiles from the database, edit loaded load profiles or define your own load profiles. 

2. Click on the Load button and select a load profile from the list which best meets your requirements 

and confirm your selection by clicking OK. 

3. Enter a name for the load profile in the text field of the dialog window. 

4. Choose a tab to select the day profile to be edited. 

Summer = May, June, July, August 

Winter = November, December, January, February 

Transitional seasons = March, April and September, October 

5. In the selection field on the left, select one hour of the day. The corresponding percentage power 

consumption is edited in the input window above the selection field. 

6. Repeat this procedure for all hours you wish to edit. 

7. The Total of percentage values of power consumption is shown below the selection field. This Total 

must come to 100%. You can achieve this by either adjusting the values or clicking the Standardize 

button. The program now averages the values in line with your settings. 

8. The percentage power consumption values of one day can be transferred to another day using the 

Copy and Paste buttons. 

9. The Annual Profile tab shows the load profile of the entire year; this can also be edited. 

10. Click Save and then enter a name to save your personal load profile. 

You can then use these load profiles for defining consumption as described above. 

4.2.2 Database Selection 
Menu Databases > From-Grid Tariff / Feed-in Tariff/  Load Profiles / PV-Modules / Inverter 

All available modules, inverters, or manufacturers are displayed in the respective dialog.  

Tree (left side) 

•  Groups (manufacturers or countries) are shown in alphabetical order on the left-hand side. 

•  A group and all its products can be added to Favorites. The favorites list gives you easy access to the 

products you are using frequently. 

Product Table (right side) 

• On the right side, all products from the selected group are shown in a table. 

•  Sort the products by clicking on the column header of the respective parameter. 

• In addition, the column can be moved to a different position by dragging and dropping 

 the column header.   
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• You can add further characteristics of the product to the table in the 

dialog   Column Selection. 

 

 

 

 

 

 

 

 

Creating and Editing Data Records  

New data records can be created, existing data records can be 

edited, copied and deleted. 

The program distinguishes between system data records and 

user data records: 

• System data records are those included in the program 

delivery. 

• User data records are created by the user. Only user data records can be edited or deleted. Select a 

row, open the context menu (right-mouse click) and choose Edit. In the dialogs displayed, From-Grid 

Tariff, Feed-in Tariff, Load Profiles Module parameters, Inverter parameters, Additional Generator 

Parameters ), you can change the individual parameters. 

Search and Filters 

Search for a product type by entering the name or part of it into the field Search by Model. 

An asterisk (*) as an initial wildcard can stand for any characters. 

Individual products can also be added to Favorites. 

By activating a check box, only user data records or   data records no longer available can be displayed. 

Data Record Selection 

If the dialog was started from a page in the assistant, the data record can be imported into the project by 

selecting OK. 

If the dialog was started from the menu Databases, the data records can be displayed (and edited), only. 

4.3 Options 
Menu Options 

These options are available for all projects in PV*SOL basic, and therefore are not dependent on the project 

selected. They are preserved when you close the program. 

User data 
Menu Options > User Data 

Here, you can enter your company name and address, and insert a company logo. These appear on the title 

page and in the header of the presentation. 
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Program Options 
Menu Options > Program options 

Here, you can define the directory for your project. 

 Automatic Update: When starting up for the first time on a given day, the program checks whether a new 

release or an updated database is available on the Internet and on request downloads and installs them 

If you disable this function here, you can perform the update manually through the menu Help > Check for 

updates. 

Database  update 

The manufacturers of PV modules and inverters expand and maintain their data records via the Internet 

using our on-line databases. These additions are checked by us and made available to you in regular 

database updates. You therefore always receive the current and valid PV modules or inverters. 

If no Internet access is available in your workplace, the database can be downloaded from a different 

computer and imported (through the menu Databases > Import ). 

! If a program update is available, it must be installed first, before any database update can be made. 

Program  update 

The program is extended with new product characteristics and known problems are fixed. These 

improvements result in regular releases available via a program update. 

Regional Options 

Changes made here immediately change your currently open project and new projects will be created using 

this default data.   

-> Proceed as follows: 

1. Select a unit system: SI, US or SI units and American Wire Gauge. 

- SI: All units are displayed in the metric system. 

- US: All units are displayed in US units. This applies to lengths and temperatures, as well as cable 

cross-sections (AWG). 

- American Wire Gauge (AWG) and encodes the diameter or cross section of a wire. This cable 

designation is generally only used in the USA, however it is occasionally also used in European data 

sheets.  

2. Select the Country and Climate Data-location  

Country & climate data will be preset for all new projects. 

3. Select the Region 

New projects are based on a template for this region, which contains typical default data e.g. for the 

inverter selection. 

- Region Germany: The maximum unbalanced load is limited to 4.6 kVA. See  

- Region USA: The maximum system voltage (direct current) is limited to 600V and the  calculation is 

based on NEC temperatures.  

Reset 

• Reset options : The language, all options and all default values are reset to factory default settings. 

This also applies to values that you have specifically stored as a default: Relay criteria, boundary 

conditions for the inverter configuration, mains voltage and the configuration of the presentation. 
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• Reset databases : The  database is reset to the factory default settings. User-created records will be 

lost. 

! BUT: Projects that contain user-created records will continue to function. The records will be recreated 

when called up. 

• Reset Program Options and Databases 

4.4 Language Menu 
Use the menu Language to switch to another language: English, French, German, Italian or Spanish. 

4.5 Menu Help 
The menu Help offers access to 

• the complete help content  

- The F1 key opens the same help file in a  context-sensitive manner, i.e., for each and every program 

dialog at the corresponding piece of text. 

• the user Manual, the same info, intended for printing, 

• the Check for updates, if you want to trigger the update check manually, (otherwise see Options > 

Program Options > automatic update check) 

• the software Registration, in order to upgrade from the unregistered demo version to the full version. 

Serial number and activation key code are available here. 

• Info ... about the program, contact addresses, system and license agreement. 
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5 Project Data 

Page Project data 

Here, you can enter the data for your project: 

• Project name 

• Quotation number 

• Contact person 

• Start Date 

System location 

• System address (enter the zip code, Search click on > City and State are filled in automatically) 

This address should match to the  climate data selected on the System type and Environment pages. 

! Based on the zip code, the current provider and eligibility requirements for web-based economic 

efficiency study are determined for locations in the USA. 

Click on : The Address field shows how the address will appear in the project report. 

You can edit in this window, e.g. enter address supplements, but these changes will be overwritten 

again as soon as you click on . 

• Project description 

• Project view 

This project data appears on the title page or the header of the presentation. 

Customer Details 

-> Proceed as follows: 

1. Click on the Customer Details button > Edit 

2. Enter your customer's contact information such as the customer number. 

3. You can either import the  system address or enter a customer's address. 

4. Click on : Check how the address is displayed in the project report. 

5. Close the dialog by clicking OK. 
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6 Type of System and Environment 

Page System Type and Environment 

Climate data 

Climate data allow you to determine the climate values to calculate the annual energy yield of the solar 

system. 

Clicking the Selection opens the Meteosyn climate data selection, structured according to the countries 

of the world. Postal codes, latitude, and longitude help you to find the right data record. 

Choose a climate data record as close as possible to your project location.  

6.1 MeteoSyn 
The MeteoSyn module provides location-dependent climate data used in the simulation programs from Dr. 

Valentin EnergieSoftware GmbH. 

Climate data for the U.S.A. are provided by TMY3. 

Using the MeteoSyn climate data generator, you can select a location 

• map: from an interactive map. 

! This only works with an internet connection! 

The geographical data of a location can be specified using the ZIP code search. 

• List: select location from a list or 

• Options: load other climate data record files in .wbv format. 

6.1.1 Select climate data from a map 
MeteoSyn > Map 

 

Image: MeteoSyn > Map 

Load climate data records 

! The button and page Create climate data for new location is not available in Express or Basic program 

types. 

Ł How to select climate data: 

1. Select a country. The map shows the selected country if you have a connection to the internet. 

Otherwise see below.  
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The country list contains those countries for which climate files are available. 

The location list contains the locations in these countries for which climate files are available. 

If federal states have been entered in the climate data, you will see a dropdown box for the federal 

states. 

Ł There are various ways of shortening the location list: 

2. Select a federal state. 

3. Enter part of the location name in the filter below the location list. 

Example: filter = "town" 

-> The list shows locations including the string "town" somewhere in their name. 

4. Enter a ZIP code. Click Start.  

The location found is marked in red , available climate data locations in the geographical vicinity 

are marked green . The location list is reduced to these nearby locations and the town, if available. 

If the ZIP code search returns no results, this is displayed in the information field. 

Ł Working with the selected location 

5. Click on a green mark  to view the location name and further information. Click on the location 

name in the pop-up to select this location. This location is then listed under Selected Location 

6. Or click on a location in the location list. This location is then listed under Selected Location, moved 

to the center of the map, and highlighted on the map with a mark .  

Click on the mark to view further information such as average temperature and global radiation. 

Right-click on a location in the location list to open the corresponding folder in the file explorer. 

7. Click on OK to continue working with this location. The selected climate record is imported into the 

program. 

8. Click the Cancel button to cancel your changes. 

! The interactive map requires a connection to the internet. 

If you do not have an internet connection, MeteoSyn opens with the List page 

On the Map page, the map is grayed out and a button to test the internet connection is shown. 

Reestablish the internet connection, click on Test Internet Connection and update the website to regain 

access to the map. 
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6.1.2 MeteoSyn, select climate data from a location table 
MeteoSyn > List 

 

Image: MeteoSyn > List 

No internet connection is required for this dialog. 

The country list contains those countries for which climate files are available. 

Ł How to select climate data from the location table: 

1. Select a country or federal state and enter a filter for the locations.  

The locations shown in the table correspond to your entries 

The parameters displayed include ZIP code, irradiation, average temperature, latitude and 

longitude, and data source. 

2. Click on a column heading to sort the table by a specific parameter.  

You can right-click a location in the table to open the corresponding directory in the file explorer 

(this is not required for the selection here). 

3. Click on the location in the table to select it. 

4. Exit the dialog by clicking OK.  

The selected climate record is then imported into the program. 

Click the Cancel button to cancel your changes. 
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6.1.3 File Import and Database Update 

MeteoSyn, import climate data from a .wbv file 
MeteoSyn > Location Data 

 

Image: MeteoSyn > Options 

Ł  How to add a climate data file to a location: 

1. Click on the select .wbv file button and navigate to the desired file. Select one or several files and 

confirm by clicking Open. These files are imported to the database and copied for all users to a 

specific folder , e.g. C:\Users\All Users\Valentin EnergieSoftware\Meteo2\_UserFiles\USA\. 

2. Exit the dialog by clicking OK. 

Update MeteoSyn Database 

If the content of that folder has been changed outside of MeteoSyn (e.g. in the file explorer) while you have 

been working with MeteoSyn, you can rebuild the MeteoSyn database by clicking the Update Database 

button. 

The database is automatically rebuilt following a reinstallation of the MeteoSyn module. Depending on the 

number of climate data records and your computer's processing power, this may take some minutes. 

6.2 AC Grid 
Page Type of System and Environment > AC Mains 

The properties of the AC network are also set here. These are: 

1. The Mains Voltage: in 1- or 3-phase networks; typically 230 V. 

In the case of two-phase systems with 120V, a split-phase topology is assumed, i.e., the two 

phases, L1 and L2 are phase shifted by 180 degrees between each other and so have 240V voltage 

difference. As a result, both 120V and 240V devices (appliances, extra generators and inverters) can 

be connected. 

2. The number of phases that make up the AC mains. Small systems are generally operated on a single 

phase, and larger systems on three-phases. In North America, two-phase topologies (including split 

phase or single-phase three-wire type networks) are also used. 

The standard values saved here can be changed. The mains voltage can be stored as a default so that it 

always has this value in newly created projects. 
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6.3 Type of System 
There are different system types: 

• Grid-connected system with full supply, i.e., 

excluding own use 

• Grid-connected system for System locations in 

the USA: determination of potential subsidy 

and the economic efficiency with the help of a 

we service. 

-> see Financial Analysis USA - web service 

  

 

• Grid-connected PV system with electric 

appliances (so-called "Own Use") and Excess 

supply 

-> Activates the Consumption page. 
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7 Consumption 

Page Consumption 

7.1 Load profile - List of Appliances ....................................................................................................... 30 

7.1.1 Load Profile - Appliances via Load Profile ................................................................................. 30 

7.2 List of  Individual  Appliances ........................................................................................................... 31 

7.2.1 Define  an Appliance ................................................................................................................. 31 

7.2.1.1 Individual Appliances: User-Independent Appliance ..................................................... 33 

7.2.1.2 Individual Appliances: User-Dependent Appliance ........................................................ 33 

7.2.1.3 Individual Appliances: Short-Time Use Appliance ......................................................... 34 

7.2.1.4 Individual Appliance: Light .......................................................................................... 34 

 

-> Prerequisite:  

Type of system: Grid connected PV system with electrical appliances - Net Metering 

Total Consumption 

-> Define the power consumption to be covered by the PV system as follows: 

1. This diagram shows the total consumption for a year. 

 

2. Define the consumption of the connected devices by assembling load profiles and individual 

appliance groups.  

Load profiles represent appliance groups. 

3. You can specify load profiles for each of the appliance groups: Specify a load profile: 

Click on  Load Profile   Selection:  

This will open a window that will show you a list of the appliances used. 

-> For details, see Load Profiles 

-> You can create and edit load profiles yourself in the Databases > Load Profile  menu. 

4. Appliances can be specified for individual consumers for each consumption group: 

Enter an individual appliance group: 

 Click on the individual appliances  Selection to create or edit the appliance.  
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This opens the Definition of electrical appliances via the individual appliances dialog. 

-> For details, see Individual Appliances 

5. The peak consumption and the total consumption are displayed in the lower Consumption Values 

range and in the Project Status window. 

Consumption Values  

You see the calculated value: Annual Consumption. 

7.1 Load profile - List of Appliances 
Page Consumption > Select Load Profile > Definition of Electrical Appliances by Load Profile 

A list of appliances on the left displays names and total annual energy consumption, 

including the Total annual energy requirement calculated from these and the hourly maximum value. The 

hourly maximum value is the maximum energy requirement that occurs during an hour of the year.  

The New Consumer and Close buttons are located at the bottom right. 

-> Proceed as follows: 

1. Click on New Load Profile  to create another electrical appliance. 

Up to four electrical appliances can be defined. 

2. Click on the symbol for electrical appliances , to open the Electricity consumers dialog for 

selected consumers. 

-> For details, see Load profile - Appliances via load profile 

3. Repeat the process for all relevant consumers. 

The Total annual energy requirement and the hourly maximum value that you have calculated are 

displayed in the individual consumers. 

4. Exit the dialog by clicking   Close. 

7.1.1 Load Profile - Appliances via Load Profile 
Menu Appliances > Load Profiles: Selection > Definition of electrical Appliancesby Load profile > Electrical Appliancesby Load Profile 

Ł  Proceed as follows: 

1. Click on the  icon to open the dialog Electrical Appliances by Load Profile. 

2. Enter a name. 

3. Define the Electricity Requirement , i.e., the Annual Energy Requirement in kWh, as well as the Weekend 

Consumption for Saturdays and Sundays in % of the weekday requirement. 

The maximum hourly value is calculated and displayed. 

4. Load and edit a consumption profile from the database by clicking on the  Consumption Profiles 

button. 

The profile name is displayed. 

5. Define up to three holiday periods by clicking on the Holiday Periods button. 

- The dialog "Holyday Periods" opens. 

- Enter up to three holyday periods , use the format dd.mm. 

   If you do not want to enter any holiday periods, enter the same dates in both/all entry fields. 

- Allocate them electricity requirements as a % of working day consumption. 

- Confirm and exit with OK. 



Graph Window 

31 / 82  Dr. Valentin EnergieSoftware GmbH 

6. Click on the Graphic button to show the consumption profile as a graphic. 

- You can modify the layout of the graphic.  

-> more details see 13.2 Graph Window 

- You can copy it to the clipboard or print it out by using the menu File > and the toolbar of the dialog. 

- You can export the numeric values of the consumption profile to a spreadsheet: 

   Right-click the X-axis and then on Scaling (context menu) tto set the display interval and the bar width. 

   Confirm with OK. 

The values have now been copied to the clipboard and can be copied into a spreadsheet. 

7. To delete this appliance, check the box Delete Appliance and confirm that you want to delete by 

clicking OK. 

8. Confirm and exit with OK. 

-> See also: 4.2.1  Defining load profiles   

7.2 List of  Individual  Appliances 
Page Consumption > Individual Appliances:  Selection  > Definition of Electrical Appliances by Individual Appliances 

Consumption of up to individual appliance can be entered . 

-> Proceed as follows: 

1. Click the button 

New, to create an individual appliance, 

Load, to open an individual appliance, 

Delete, to remove an individual appliance,. 

2. The selected individual appliance is displayed on the left. 

 
To define the hourly basis and the other properties of an individual appliance, click on the  icon 

left of the name of the individual appliance in the list. The Individual Appliances dialog window 

opens. 

-> more details refer to:  Define an Appliance 

3. The total annual energy requirement and the maximum hourly value are calculated and displayed 

below the individual appliances. 

The maximum hourly value is the highest possible energy requirement of an hour, over a whole year. 

4. Exit the dialog with Close. 

7.2.1 Define  an Appliance 
Page Consumption > Individual Appliances:  Selection  > Definition of Electrical Appliances by Individual Appliances >  Individual 
Appliances 

-> Proceed as follows: 

1. Click the button Load to open a list of included individual appliances to select one as basis for your 

own appliance. 

2. Enter a name for the individual appliance 



Manual PV*SOL basic 6.0 

Dr. Valentin EnergieSoftware GmbH  32 / 82 

3. Open the list of Types  of individual appliance   and select one. The different types constitute 

different operating periods, and therefore different dialog contents are displayed 

 User-independent appliance (e.g. refrigerator) 

 User-dependent appliance (e.g. television) 

 Short-time use appliance (e.g. coffee machine) 

 Light 

4. Enter, if applicable, the Power [W] and the Standby Power [W] and, for user-independent appliances, 

the Annual Energy Requirement [kWh]. 

5. Operating hours 

Depending on the choice of Type, further time definition options are shown in the lower part of the 

dialog window, using which you can define the individual consumption behavior of the appliance: 

 

Appliance type Operating hours - Definitions 

  
 all days the same 

/ Day 
12 Months  24h Day 

 User-

independent 

appliance 

  x   

 User-dependent 

appliance 
x x x 

 Short-time use 

appliance 
x x   

 Light x x x 

        

-> Instruction: 

Uncheck  the 

option "all days the 

same" and define 

individual daily 

reduction times. 

in Operation: Click 

on month field or 

 day field (green) 

Not in Operation: 

Click on month field 

or 

 day field (white) 

in Operation: Click on hour field 

(green) 

Not in Operation: Click on hour 

field (white) 

• User-independent appliance: 

- appliance runs constantly or 

- appliance runs every X hours/Minutes.The duration is calculated automatically from the annual energy 

requirement  and, if applicable, the Stand-by Input, you have entered. 

- In combination with the months and days in use, the total number of operating days is calculated and 

displayed. 

• User-dependent appliance: 

- nightime only: Operating hours are valid, if simultaneously, the global irradiation is zero. 

- daytime only: Operating hours are valid, if simultaneously, the global irradiation is bigger than zero. 

- in combination with all days the same / Day 

- In combination with the months and days in use, the total number of operating days is calculated and 

displayed. 
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• Short-time use appliance: 

- Enter the period of use  in [min] or energy requirement in [kWh] per use. 

- Enter the number of uses per hour (in combination with all days the same / Day). 

- in combination with the months and days in use, the total number of operating days is calculated and 

displayed. 

• Light: 

- in total darkness: The given operating hours are valid, if simultaneously, the global irradiation is zero. 

- at dusk: The given operating hours are valid, if simultaneously, the global irradiation is less than 20 

W/m². 

- cloudy weather: The given operating hours are valid, if simultaneously, the global irradiation is less 

than 50 W/m². 

6. Click on Save to store your entries. 

7. Exit the Dialog with OK. 

7.2.1.1  Individual Appliances: User-Independent Appliance 
Page Consumption > Individual Appliances:  Selection  > Definition of Electrical Appliances by Individual Appliances >  Individual 

Appliances 

A user-independent appliance is not normally switched on and off by the user, but runs automatically for 

long periods of time – e.g. refrigerator, deep-freeze. 

Stand-by: an entry is not possible in the case of an appliance in constant use. 

Annual Energy Requirement: the annual energy requirement should be given for general operation over the 

whole year. 

Operating Times: 

 Appliance in Constant Use: the appliance is generally switched on the whole time. 

 Switch on Every…: sets the switching-on interval. Define the appliance by the intervals it remains 

switched on. 

7.2.1.2  Individual Appliances: User-Dependent Appliance 
Page Consumption > Individual Appliances:  Selection  > Definition of Electrical Appliances by Individual Appliances >  Individual 
Appliances 

A user-dependent appliance is used regularly and at certain times, eg TV, computer. 

Stand-by: an entry here is only made for appliances with this facility where stand-by is always active when 

the appliance is not in operation. 

Operating Times: 

Clock: the hours of operation are set by clicking on the fields (green field = in operation, white field = 

not in operation). 

 All days the same: if the tick is removed, it is possible to enter different operating times for all the 

days of the week. 

No Other Restriction: the operating times are as defined by the clock. 

 Nights Only: the operating hours are only valid if, at the same time, global radiation equals zero. . 

 Days Only: the operating hours are only valid if, at the same time, global radiation is greater than 

zero. 
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in use: click on month or 

day (green) 

out of service: click on month or 

day (white) 

in use: click on hour field (green) 

out of service: click on hour field (white) 

  

7.2.1.3  Individual Appliances: Short-Time Use Appliance 
Page Consumption > Individual Appliances:  Selection  > Definition of Electrical Appliances by Individual Appliances >  Individual 

Appliances 

A short-time use appliance is a user-dependent appliance that is generally switched on for less than an hour 

each time it is used, e.g. iron, coffee maker. 

Output: Electricity requirement in [kWh] per use 

Stand-by Input: an entry here is only made for appliances with this facility where stand-by is always active 

when the appliance is not in operation. 

Operating Times – per use: 

• Enter the period of use or 

• enter the electricity requirement per use 

Hourly Use: 

• Enter the number of uses per hour for each hours of the day in the bar. 

• If the tick is removed at All Days the Same, it is possible to enter hourly use separately for each day of 

the week. 

7.2.1.4  Individual Appliance: Light 
Page Consumption > Individual Appliances:  Selection  > Definition of Electrical Appliances by Individual Appliances >  Individual 

Appliances 

An appliance is defined as a light when it is switched on depending on the amount of daylight. 

Output: Electricity requirement in [kWh] 

Stand-by Input: an entry here is only made for appliances with this facility where stand-by is always active 

when the appliance is not in operation. 

Operating Times: 

 All days the same: if the tick is removed, it is possible to enter different operating times for all the 

days of the week. 

Clock: The hours of operation are set by clicking on the fields (green field = in operation, white field = 

not in operation). The appliance can only operate within the defined operating hours. 

No Other Restriction: the operating times are as defined by the clock. 

Full Darkness: the operating hours are only valid if, at the same time, global radiation equals zero. . 

Dusk: the operating hours are only valid if, at the same time, global radiation is less than 20 W/m². 

Dull Weather: the operating hours are only valid if, at the same time, global radiation is less than 

50 W/m². 
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8 PV Modules 

Page PV Modules > Module area i 

8.1 Roof coverage with Photo Plan ........................................................................................................ 38 

8.2 Roof Covering ................................................................................................................................. 39 

8.2.1 Roof View - Toolbar .................................................................................................................. 40 

8.2.2 Tree view ................................................................................................................................. 41 

8.2.3 New 2D Object.......................................................................................................................... 41 

8.2.3.1 New Roof Area .............................................................................................................. 41 

8.2.3.2 New Barred Area .......................................................................................................... 42 

8.2.3.3 New PV Area ................................................................................................................ 43 

8.2.4 Editing Coordinates, Orientation, Position, Installation Type ..................................................... 44 

8.2.5 Border Distances ......................................................................................................................47 

8.2.6 Module coverage ......................................................................................................................47 

8.2.6.1 Calculate the Optimum Row Distance ........................................................................... 48 

8.2.7 Roof - Messages ...................................................................................................................... 48 

8.2.8 Workflow ................................................................................................................................ 49 

8.3 Losses ............................................................................................................................................. 51 

8.4 PV Module Parameters ..................................................................................................................... 51 

 

On this page you can select modules from the database and set the parameters for the module area.  

-> Proceed as follows: 

1. Name the collector surface in the tree register to the left.  

2. Module data: Here, you can select a PV module: 

Click on the Select button to open the database for the PV module. 

-> see also: Database selection 

3. Select a PV module type. The records are regularly maintained and expanded by the manufacturers. 

You can obtain the newest records via the database update. 

4. Type and rating are displayed. Other module values for this module is available by clicking on . 

5. You can create a view of the building with solar panels using Photo Plan You can include these views 

in the presentation to the customer. 

At Photo preview of the roof coverage with Photo Plan click on the button Edit. 

-> proceed with:  Photo Plan 
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 Input of Module Area: Graphic Coverage: 

6. At  Input of Module Area, select the Graphic Coverage option. 

The roof view and coverage will be displayed. 

7. Click on the button   Input, to determine the number of PV modules, their orientation, inclination 

and installation type by entering the roof coverage with the respective barred objects. 

-> proceed with: Graphic coverage 

 Input of Module Area: Direct Data Input: 

6. Input of module area: Select Direct Data Input.   

Define the mounting position parameters, tilt angle, orientation, and number of modules. 

7. Enter the number of modules (maximum = 1000 modules). 

8. Click on the Desired Generator Output link. 

- Enter the value in kWp.  

- Confirm your entries by clicking OK. 

9. Click on the link: Desired PV fraction of consumption and annual consumption. 

- Enter the following values depending on the system type 

System type  full feed-in  net-metering 

available values 
- desired PV fraction of consumption 

- annual consumption 

- desired PV fraction  of consumption 

- assessment period 

- Confirm your entries by clicking OK. 

The number of modules required to generate the entered percentage of necessary energy is 

calculated and displayed 

10. The orientation describes the position of the collector surface with respect to the geographic 

direction. It is independent of climate data location, i.e. the same whether in the northern or 

southern hemisphere. The compass rose illustrates your entries. 

  Orientation   Azimuth 

      
Northern 

hemisphere 

Southern 

hemisphere 

North 0 

 

180 0 

East 90 -90 90 

South 180 0 180 

West 270 90 -90 

The azimuth  depends upon the exact climate data location which was selected on the System type 

and environment page in the climate data. It describes the collector area's angle of deviation from 

the south (northern hemisphere) or from the north (southern hemisphere). It is 0° (in the northern 

hemisphere) when the area is exactly oriented to the lunchtime position (zenith) of the sun. 

PV*SOL detects whether the system is in the northern or southern hemisphere from the climate data 

record, which includes the degree of latitude. 
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11. Installation Type: 

Select a type of installation: 

o Flush mount, if the modules are mounted a distance above the roof cladding. 

o Roof integrated - rear ventilation if the system will be installed on a support structure parallel to 

the roof cladding. Rear ventilation helps to cool the modules and thus higher performance. 

o Roof integrated - no rear ventilation if the module forms the roof cladding. 

o Mounted - roof, if the modules are mounted directly on the roof. 

o Mounted - open space, if the modules are mounted at ground level. 

12. The Inclination of the PV module describes the angle between the horizontal position and the 

module area: 

o 0° corresponds to a horizontal position, 

o 90° corresponds to a vertical installation. 

The PV generator output is calculated and displayed. 
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8.1 Roof coverage with Photo Plan 
System definition > Collector array > Photo Plan 

Page PV module > Preview of the roof configuration with Photo Plan  

Using Photo Plan, you can create a photorealistic plan of your roof areas. The number of modules and tilt 

angle are determined. You can apply these values. They need not necessarily coincide with the number of 

modules of the project. For example, if dummy modules are included in the photo preview. 

-> How to proceed: 

1. The program Photo Plan is opened. 

2. There are two detailed instructional videos on how to use Photo Plan (see below). It is recommended 

that you view the introductory video. 

3. With just a few entries on the geometry of the roof, it is possible to gain an impression of the future 

look of the roof areas. You require only a photo of the roof. Photo Plan imports the dimensions for 

the selected module from PV*SOL basic  

4. Here you can export the roof with some solar thermal modules as a Photo Plan project, and import it 

into PV*SOL in order to fit the remaining area with photo-voltaic modules in PV*SOL. Of course, you 

can also do this in the reverse order. 

5. In addition, Velux® skylights and Braas® roof tiles can be included and displayed 

6. The finished photo, number and inclination of modules will be adopted by PV*SOL basic. 

Ł See also: 

• Photo Plan - Introductory video: http://valentin-

tutorials.s3.amazonaws.com/PhotoPlanTutorials/EN/PhotoPlan_EN_1/PhotoPlanEN1.html 

• Photo Plan - Advanced functionality: http://valentin-

tutorials.s3.amazonaws.com/PhotoPlanTutorials/EN/PhotoPlan_EN_2/PhotoPlanEN2.html 

Before   After   
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8.2 Roof Covering 

Page PV Modules > (Determine PV System DC Output from) Roof Mounting >  Input 

System > Technical Data > (Generator Output) Determine Output from Roof Area > Roof Parameters  > Cover Automatically (context menu 

on roof visualization) 

The Roof  view shows your current roof project including the PV areas and barred areas. 

-> Requirements: 

1. Select at Determine PV System DC Output from  the option Graphic Coverage 

2. Click the button Input 

  

This is the general, operational procedure: 

1. Enter the dimensions, orientation and inclination of the roof. 

2. Define the barred area. 

3. Determine the mounting position for the PV modules. 

4. Cover the roof with PV modules. 

5. Enter the dimensions, orientation and inclination of the PV area. 

  

-> Proceed as follows: 

1. The roof view is displayed. Enter the chimney and other barred areas as new 2D 

objects and borders. 

• You can drag and drop PV areas and barred areas to move them. 

• If a 2D object is selected, its corner points are shown and can be edited in the input 

field. 

• The compass rose at the upper right of the image shows in what direction the roof (arrow in the color of 

the roof) is oriented. The orientation of mounted PV modules (blue arrow) can differ from that of the 

roof. 

It shows the direction that the roof faces. 

2. Click on the roof area and right click to open the 

context menu.  

3. Select Cover automatically or use Edit PV Area. 

The following keyboard shortcuts are available for 

editing the module formations: 

• CTRL + left mouse key:         Multiple selection 

• SHIFT + left mouse key:        Row selection 

• ALT + left mouse key:           Column selection 

4. Reduce or enlarge the Roof View using the middle mouse button/mouse wheel. 
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8.2.1 Roof View - Toolbar 
Page PV module > (entering the collector surface) Graphic layout > Input 

 

 Create New 2D Object 

The Create New 2D Object button opens up the New 2D Object dialogue. There you can  define new roof 

areas, barred areas or PV areas. 

    Copy 2D Object 

After you have selected a barred area or PV area, you can copy this to a clipboard by clicking the Copy 2D 

Object button (or by pressing CTRL+C). You can then paste that barred area or PV area into its roof area 

by right-clicking and selecting Paste (or by pressing CTRL+V). 

   Delete 2D Object 

Click the Delete 2D Object (or press the Delete) key to delete selected barred areas, PV areas or modules 

and/or module formations. 

    Delete All PV Areas 

Attention! Clicking the Delete all PV Areas button deletes all PV areas. 

    Delete all 2D Objects (except roof) 

Clicking this button deletes all 2D objects except the roof area. 

    Zoom - Enlarge View 

This button enlarges the view of the roof area. 

    Zoom - Reduce View 

This button reduces the view of the roof area. 

    Zoom - Select Best View  

Clicking this button sets the optimum zoom factor. 

  Display Module Angle  

for roof plan modules, for sloped, mounted modules:  

The arrow indicates the bottom of the module. 

  

  

Coordinates 

Displays the actual position of the cursor. 

Distance point i 
The area of the toolbar to the right shows the distance of a selected barred or PV 

area point from the outer borders of the roof area. 
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8.2.2 Tree view 
System (2d) > Technical Data > Array i > Roof Parameters 

The tree view gives you an overview of the 2D objects that are used in your PV system. 

 

Left-click on an element in the tree view to select the 2D object. 

Right-click on a 2D object in the tree view to open a context menu with all the available commands for the 

selected 2D object. 

 

 

8.2.3 New 2D Object 
Page PV modules > (Entering the collector surface) Graphic layout > Input > 

Here, you can define new 2D objects for your project. 

-> Proceed as follows: 

1. Click on the button . This opens the "New 2D object" dialog. 

2. Select an  object type at the top left: 

Roof area, 

barred area or 

PV area. 

3. Then enter a name for your new 2D object under Designation. 

4. Depending on the selected object type, various Standard Forms and Options are available for 2D 

objects: 

8.2.3.1 New Roof Area 

Page PV Modules >  Graphic Coverage > Input > New 2D Object > Roof 

-> Proceed as follows: 

1. Enter a reference name for your new 2D object. 

2. Open the window Border Distances  where you can specify barred areas for the borders of your 

roof. 

3. Select one of the geometric standard forms: 
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Rectangle 

 

Trapezium 

 

Triangle 

 

• Enter the sizes of the shape. 

• For simple roof areas without barred areas and border distances: 

Tick the Cover roof to maximum box to give the new roof area a PV area the same size as your roof. 

PV modules will then be added automatically when you click on OK. 

• If needed, repeat the same procedure for Barred areas  and the PV area. 

• Close the dialog using OK. 

The roof is displayed accordingly. 

8.2.3.2 New Barred Area 

Page PV Modules >   Graphic Coverage > Input >  New 2D Object >   Barred Area 

-> Prerequisite: 

You have defined the roof area. 

-> Proceed as follows: 

1. Enter a reference name for your new barred area. 

2. Select one of the geometric standard forms: 

Rectangle 

 

Trapezium 

 

Triangle 
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Circle 

 

3. Enter the dimensions of the shape. 

4. Repeat the process as needed for  PV areas. 

5. Close the dialog using OK. 

The roof is displayed accordingly. 

  

8.2.3.3 New PV Area 

Page PV Modules > Graphic Coverage > Input > New 2D Object > PV Area 

-> Requirement: 

1. You have defined the roof area. 

2. You have defined necessary   barred areas. 

-> Proceed as follows: 

1. Enter a reference name for your new PV area. 

2. Select one of the geometric standard forms: 

Rectangle 

 

Trapezium 

 

Triangle 

 

3. Enter the dimensions of the shape. 

4. Or, if needed select the option  "Fit to roof area" 

 
The new PV area takes over the shape and dimensions of the existing roof area.   
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5. Or, select the option  "Based on number of modules": 

 
The size of the new PV area is determined for a specified module formation. 

- Enter the number of rows (X-axis) and columns (Y-axis) for the planned module formation. 

- The resulting power of the module formation is displayed. 

6.  Tick the Cover roof afterwards box to add PV modules to the new array area automatically after 

you click on OK. 

7. Close the dialog using OK. 

The roof is visualized accordingly.   

8.2.4 Editing Coordinates, Orientation, Position, Installation Type 
System (2D) > Technical data > Sub-array > Roof parameters > Click in Tree View 

Page PV module > (entering the collector surface) Graphic layout > Input > (select roof area) > (input field below) 

The appearance of the input field below the roof view varies depending on the type of object that is selected 

in the tree view.  

Current Roof 

1. Select Current Roof in the tree view. The labels of the roof boundaries and the current color of the 

roof are displayed in the input field. 

 

2. You can change the labels. 

3. Click on Color of Roof  to the right on the image element in roof color if you wish to select another 

color. 

Roof Area 

1. Select a roof object in Tree View (default: Roof View). The coordinates for the points of this object 

will be displayed in the input field. 

 

2. You can edit the coordinates of individual points of the selected object. 



Graph Window 

45 / 82  Dr. Valentin EnergieSoftware GmbH 

3. You can  add or  remove points. 

4. Click the  button to open the Border Distances window. 

5. You can also enter the roof orientation and the roof angle at the right. The arrow in the compass dial 

indicated the direction of the roof. 

Restricted Area 

1. Select a barred area in the tree view. 

2. You can edit the coordinates of individual points of the selected object. 

3. You can enter the position of the entire selected object under Enter Position. 

 

PV Area 

1. Select a PV area in Tree View. 

 

2. You can edit the coordinates of individual points. 

3. You can  add or  remove points. 

4. The  button (to the right of the coordinates) opens the Module Coverage dialog. 

5. Edit the position of the PV area and the position of the PV module array as needed. 

6. Select an installation type: 

• Roof integrated - no rear ventilation 

• Roof integrated - rear ventilation 

• Flush Mount 

• Mounted - roof 

• Mounted - open space 

7. Roof integrated PV modules: Module azimuth and module inclination are displayed. They adapt 

automatically to the roof area parameters (see above). 
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8. Mounted PV module: 

 
- Enter the module Azimuth (i.e. orientation. 

   If you rotate the module, the module coverage is recalculated. 

- Enter the module inclination ß1.  The steeper the tilt angle, the more modules can be mounted on 

the surface: 

   30°:      85°:  

   If you change the inclination, remember to adapt the row distance, in order to minimize shading.   -

> see Module coverage.  

   The orientation to roof edge and the mount angle is calculated and displayed. 

- Click   to display additional angles and dimensions in the Row Distance window. 

- Select the Align to Roof Edge option to arrange the modules parallel to the edge of the roof: 

  before:  after:  
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8.2.5 Border Distances 
Page PV Modules > ( Entering collector surface )   graphic 
coverage> Input > (Select roof area) > (input field below) Edge 
distances  

You can define the barred areas of a specific 

width for the edges of your roof in the "Border 

Distances" menu. 

-> Proceed as follows: 

1. Select the Roof Area in Tree View. 

2. Click on the Border Distances button 

in the Input Field. 

3. Define the border distances for each roof 

edge individually in the window on the left. 

4. If you want to define the same border distances for all roof edges, select the the For all Edges 

option and enter a value in the input field to the right. 

5. Exit the Dialog with OK. 

8.2.6 Module coverage 

Roof View > PV Area i i > Context menu Edit Coverage 

 

-> This allows you to edit the module coverage: 

1. Select a PV area in the tree view and click on the input field on the  (Edit Coverage) button. 

Alternatively, you can open the context menu by right-clicking on a PV area in the roof visualization 

or in the tree view and select Edit Coverage. 

2. Define the column spacing and the distance between rows of PV modules. The minimum distance for 

both values is 0.05 m = 5 cm. 

3. Under Installation type you can specify the module orientation (horizontal or vertical). 

4. The button Calculate Optimum Row Distance  is only available for mounted, non roof-parallel PV 

systems: By finding the optimum row distance, you can minimize mutual shading caused by 

mounted module rows. 
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8.2.6.1 Calculate the Optimum Row Distance 

Page PV Module >   Graphic layout > Input > Module  area  >    Edit PV area > Calculate Optimum Row Distance 

The optimal row distance for mounted PV systems is calculated so 

that the module rows do not shade each other at 12:00 p.m. during 

winter solstice. Thus, the mutual shading of mounted module rows 

is minimized for the entire year. 

The Row Distance is a function of the module inclination b, the 

sun's position g on 12/21 at 12:00 p.m. and the mounting height h 

of the module. 

-> To calculate the optimal Row Distance: 

1. Select a PV area and go to   Edit PV area (context menu) 

The Module Coverage dialog will open. 

2. Click on the  Calculate Optimum Row Distance button. The button is only active for mounted, non 

roof-parallel systems (-> see Installation type). The Row Distance dialog is opened.  

On the left, you will see a graphic that shows the distances and angles. 

On the right, you will see:  

Default data: module width, mounting height, module inclination ß, roof angle ß1, sun γ, as well as 

the date and time of the winter solstice Results: the calculated Row Distance d, frame spacing d1 

and the projected module width (d-d1) 

3. Confirm the acceptance of the data with OK. You will return to the Module Coverage.  

The frame distance d1 is now entered as column distance. 

4. Confirm your entries by clicking OK. Return to the roof view. 

8.2.7 Roof - Messages 
Page PV-Module  >   Graphical Covering > Input 

The messages area shows you the following information: 

1. Type of installation 

2. PV generator power 

3. Number of modules 

Messages about any conflicts in the roof coverage are also displayed here.   

1. No conflicts exist. 

   

2. A PV area overlaps with a barred area. 

  

3. At least one module in a PV area is located outside the roof area. 
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4. The modules of various PV areas overlap. 

 

8.2.8 Workflow 

Example for a PV system with ventilation. 

1. Specify the size of your roof area. To do this, select the roof area by left-clicking on the roof area in 

the roof visualisation or select your roof area in the tree view (default: New Roof). You can now 

specify the size and shape of your roof in the input field. 

2. First of all, delete all 2D objects by clicking the Delete All 2D Objects (except roof) button  . 

Alternatively you can delete particular 2D objects by clicking the  button, for example to obtain a 

barred area that you require. 

3. Specify the barred areas for the borders of your roof area. To do this, select the roof area by clicking 

on the roof area in the roof visualisation or select your roof area in the tree view (default: New Roof). 

Now in the input field click on the    button and define the required barred areas in the Edge 

Distances dialog. 

4. Now create a new barred area (e.g. skylights and chimney). Your roof might look something like this: 

  

5. To define a PV area that is matched to the roof area, click the Create a New 2D Object button  to 

open the New 2D Object dialog. 

6. Select PV Area in the drop-down menu at the top left. 

7. Select the Fit to roof area option for the new PV area. 

8. Now tick the Cover roof afterwards checkbox. 
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9. Click OK and PV modules will automatically be added to the roof area. Now your roof might look 

something like this: 

  

10. Now you can specify the installation type (horizontal or vertical) and the distances between the PV 

modules in the Module Coverage dialog. 
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8.3 Losses 
Page PV modules  > Losses 

Shade 

Radiation is reduced in the annual average by shading. Diffuse and direct radiation are reduced equally.  

1. Enter the shading in the annual average. 

Degradation of Module 

-> Here, you can define a performance decrease due to aging of the PV module. 

2. Estimate the degradation of module either  linearly or exponentially. 

o Linear degradation: Specify the remaining power after x number of years as a percentage. 

o Exponential degradation: Specify the remaining power after x number of years as a percentage 

for both long-term and short-term degradation. 

8.4 PV Module Parameters 
Menu Databases > PV-Modules > Edit / Copy selection 

or: Page Inverters > (Configuration for Module Area) Selection >  

The module parameters are laid out across several tabs in this dialog. The data are checked at the end of the 

entry to ensure you have correctly filled out the data sheet.  

Tab Basic Data 

Manufacturer and type may not exceed a length of 255 characters. 

Output Tolerance [%] 

The module values given are subject to certain fluctuations in manufacture. This is primarily important for 

the current, voltage, and output data. 

Cell Type 

Most cells are made of either monocrystalline or polycrystalline silicium and a few are of amorphous 

silicium. 

Dimensions Height [m], Width [m] 

Height and width determine the PV module area and thus the area of the PV array. This area, which relates to 

the module dimensions, is called the gross surface area in the program. 

Tab UI Characteristics at STC 

The entries on this page are only valid for standard test conditions (STC), i.e. 25° module temperature, 

sunlight spectrum of AM 1.5, and 1000 W/m² irradiation. 

MPP Voltage [V], MPP Current [A] 

The power output of the modules is dependent on the module temperature and irradiation, and the module 

voltage. There is a current/voltage characteristic curve for each module temperature and irradiation. The 

working point on this curve determines the module's power output. 
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The MPP is the working point on this curve (see also the UI characteristic curves button on the UI 

Characteristics at Partial Load page) at which the module's power output is at a maximum (maximum power 

point). 

The MPP voltage and MPP current are dependent on temperature and irradiation This means that the voltage 

and current entered here are only valid for standard test conditions For all other irradiation and temperature 

values, there are other MPPs. 

This has to be determined by the program (see page UI Characteristic Values at Partial Load) In the PV 

system, this job is done by the inverter. The inverter controls the PV array in such a way that maximum 

output from the current and voltage is obtained (MPP tracking). 

Open Circuit Voltage [V] 

The voltage level for a module with no load This is also dependent on temperature and irradiation. 

Short Circuit Current [A] 

The current flowing through a short circuited module This is also dependent on temperature and irradiation. 

Power Rating [W] 

Module output under standard test conditions (STC) Efficiency [%]. 

Module efficiency 

Module efficiency under standard test conditions 

For the simulation, the program uses the following formula to determine the Active Solar Surface Area from 

the Calculated Output and Efficiency: Power Rating (STC) = 1000 W/m² * ETA(STC) * Active Solar Surface 

Area. 

Tab UI Characteristics at Part Load 

On the page UI Characteristics at Part Load, enter voltage and current for a second working point The values 

at lower irradiation are important to be able to calculate the efficiency curve of the module The efficiency 

given on data sheets relates to a module temperature of 25 °C and irradiation of 1000 W/m², although, for 

most of the year, this is not reached by the PV system This is why the efficiency at lower irradiation is very 

important for the simulation results Via the Standard Part Load Behaviour button, you can let the program 

calculate the second working point. 

Tab Other Parameters 

Temperature Coefficients: Voltage Coefficient [mV/K]  

This value expresses the increase in voltage when the module temperature increases by one degree. The 

warmer the module, the smaller the voltage, i.e. this coefficient is negative. 

Current Coefficient [mA/K] 

This value expresses the increase in current (amperes) when the module temperature increases by one 

degree. The warmer the module, the higher the current, i.e. this coefficient is positive. 

Power Coefficient [%] 

The warmer the module, the lower its power output. The power coefficient is negative and is given as a 

percentage of the power rating. 
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9 Inverters 

Page Inverters 

There are two different approaches to defining a system configuration:  

For 1.) Automatic calculation of a module surface configuration 

 

1. Click the button Configuration for module area > Selection. 

2. Then click the button Selection to select one, some or all inverter(s) from the database. Confirm by 

clicking on OK. 

3. Click the button Start Search. Inverter configurations are calculated and listed. 

4. The details about the quality of a specific configuration can be viewed by clicking on the   icon. 

5. Select a configuration and confirm this by clicking on OK. 

For 2.) Editing or setting the configuration 

 

If the modules are individually configured and not interconnected, the following applies: 

Up to three inverter types can be defined. 

In the tree,  the number of each inverter  types is displayed. The toolbar or the shortcut menu can be used to 

  create,  copy, or   delete inverter types. 



Manual PV*SOL basic 6.0 

Dr. Valentin EnergieSoftware GmbH  54 / 82 

Inverter Selection and wiring 

1. Select a configuration in the treeview. The input mask for the wiring of the inverter is displayed on 

the right. 

2. Click the button Selection to select an inverter from the database. 

3. The database dialog is displayed. Select an inverter. Confirm with OK. The page Inverters  is 

displayed again. 

4. If the selected inverter allows parallel operation (see Definitions of Terms) 

the mode of the MPP-trackers is queried. 

5. Select an inverter configuration from the drop-down-list.  

Only those configurations are listed, which are matching the given 

configuration limits. If a value of the system configuration exceeds the set 

limits, warnings or error messages in the message window provide 

information on appropriate corrective measures. 

6. To get a detailed insight into the possible configurations, click the Edit button. 

Information   

The sizing factor and the current output range of configured inverter are shown in the information window. 

The dialog Configuration Check shows the values of the inverter to the chosen configuration. 

A link leads to the current configuration limits setting that can be defined for the project. 

9.1 Automatic System Configuration 
Page Inverters > (Configuration for Module Area) Selection 

Here, you select the system configuration regarding inverter, MPP tracker, and configuration.  

In the Entry Data display area, the module array entered is shown. All technical data on the module can be 

visualised via the . button. 

-> Select an inverter / inverters: 

The inverters are selected via the database Selection dialog. They are preselected by the given module 

area (page PV Modules). The selection is simplified by the Favorites category in the dialog. The 

number of selected inverters are displayed.  

-> Configuration Criteria:  
Here you define the MPP tracker occupancy and the possible number of different inverter types: 

1. Activate or deactivate free MPP trackers 

2. Specify whether the MPP trackers are covered to the maximum or as evenly as possible 

3. Select the number of different inverter types between 1 and 3. 

4. The configuration critera can be saved as defaults, so that they are available every time the program 

is started. 

-> Display dialog,  

In the Display dialog, you can define how many results are visualised per page and whether 

configurations in the tolerance range are shown. 
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-> Configuration Limit: 

In the Configuration Limits dialog, you specify how far the defined limits of the inverter manufacturer 

may be exceeded. 

-> How to search appropriate PV system configurations: 

1. Start the automatic calculation of the system configuration by clicking on the Start Search button. 

Depending on the number of modules and inverters, the search may take a while.  

The search query can be interrupted in the second phase of the algorithm. The program calculates 

all possible configurations. Similar configurations are filtered out in the third phase of calculation. 

The results are displayed in a table.  

2. All technical data on the inverter can be visualized via an  button in the column Inverter Model.  

The results are ordered such that the optimal configurations appear on the first page. The number of 

inverters, the quality of the configuration and the unbalanced load are calculated for every 

configuration. Whether the configuration lies within the tolerance or design range has no effect on 

the classification.  

3. The quality of the configuration with regard to the voltage range, current, and output can be 

displayed by clicking the   button in the column Sizing Factor. The dialog Inverter Configuration 

Values opens. 

There, a distinction is made between the inverter values and the values assigned to the individual 

MPP trackers. In this way, the user can take the qualitative differences between two configurations 

into account before selecting a configuration. 

4. Select a configuration by clicking it. 

5. Click OK to accept the selected PV system configuration for your project. 

9.2 Individual Edit Inverter Configuration 
Page Inverters > individual configuration (click single inverter in the tree view) > Edit 

The configuration can be edited in this dialog. All boundary conditions for the configuration are shown with 

colors. This helps you to enter a valid configuration.  

Inverter's Sizing Factor and Current Range 

There are two graphical bars, which represent the inverter current range and the valid sizing factor including 

the design range, tolerated design range and blocked-off range, coded in the colors green / yellow / orange, 

respectively. 

In this way, all relevant checking mechanisms in configuration of an inverter can be visualised on one page. 

The user can also define a suitable configuration. 
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Matrix on moving MPP trackers  

A matrix is presented. 

 

1. The horizontal axis illustrates the number of modules in series which can be connected to an MPP 

tracker (and the resulting MPP voltage). 

2. The number of strings (and the resulting MPP current) is shown on the vertical axis. 

3. The MPP trackers can be placed in the matrix by drag and drop or via a context menu. The colors 

(green = design range, orange = tolerance range, red = blocked-off range) make clear whether the 

MPP tracker is optimally designed or not. 

4. The design optimum for the number of modules in series is marked blue on the vertical axis. The 

configured number of modules per MPP tracker is indicated in a notice area and by the grey marking 

in the table fields. 

Additionally: 

• If you don't want to allocate this MPP tracker, drag the symbol into the field Free MPP Trackers: 

  

• The configuration check  can also be launched here. 

• The number of configured modules and the PV Generator Output is displayed at the end of the dialog. If 

the number of modules is unequal to the number you have given in the page PV Modules, a warning is 

displayed. 
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9.3 Connection limits - Configuration Limits of the WR connection  
Page Inverters > (Configuration for Module Area) Selection > Configuration Limits  

In the Inverter Configuration Limiting Conditions dialog you specify how far the manufacturers' limits can be 

exceeded. This is how you define the size of the the design area tolerance range and the restricted area  

Page Tolerances 

Here you specify the range of variation for the dimensioning factor that you will accept. You can 

differentiate between the design area and an edge area which is just in the tolerable range.  

-> Proceed as follows: 

1. Enter values for the   design area, the  tolerance range and the  barred area. 

2.  The sizing factor can be automatically calculated by the program from the location and set- up if 

you activate the relevant check- box 

3. You can set whether or not the manufacturer value for the MPP voltages and the maximum input 

current may be exceeded 

4. You may dismiss your entries by "resetting to standard" or instead, save your entries as standard. 

Page Other 

On the Other page, you can specify whether the unbalanced load in the system configuration should be 

taken into account and the level of the threshold value.  

-> Proceed as follows: 

1. Select whether the unbalanced load should be taken into account in the system configuration 

2. Enter the configuration limit for the unbalanced load. The default value for Germany is 4.60 kVA. 

3. Enter the following to calculate the operating point for the PV module for performing a power check 

 : 

- To check the minimum/maximum MPP voltage: Irradiation and Temperature 

- To check the maximum open circuit voltage: Irradiation and Temperature 

The location of the operating points can be accessed for each interconnection, by accessing the 

Connection Check. 

4. Based on the system location in the USA, select the NEC Temperature, and depending upon the 

zip code where the system is located, the appropriate module temperatures will be inserted based 

on the NEC® (National Electrical Code®). 

5. If necessary, enter the   maximum allowable System Voltage. 

6. Reactive power supply 

Enter a displacement factor cos(ϕφ)  between 0.8 and 1. 

With a factor < 1, the useable active power of the inverter will be less. 

With a cos φϕ  of 0.95, only 95% of the inverter apparent power can be used as active power. The 

inverter should therefore be sized 5 % larger. 

If the inverter is sized too small, the simulation will reveal drops in yield. 

The limits of the interconnection can be saved as standard so that the data are stored and can be used each 

time the program is started. 
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9.4 Inverter Configuration Values 
Page Inverters > (Configuration for Module Area) Selection > (any result table row, column Sizing Factor)   

For every configuration, the quality of the inverter voltage range, inverter current, and output is shown in 

this dialog.  

On the second tab, the voltage, current, and performance of the individual MPP trackers are displayed. 

The values of the given configuration are evaluated: 

 Value in the design area of the inverter/MPP tracker 

 Value in the tolerance area of the inverter/MPP tracker 

 Value in the restricted area of the inverter/MPP tracker 

In this way, the user can take the qualitative differences between two configurations into account before 

selecting a configuration. 

9.5 Inverter Parameters 
Menu Databases > Inverter > Edit 

or: Page Inverters > (Configuration for Module Area) Selection > (Inverter) Selection > Edit 

Parameters for the inverter are defined in this dialog.  

If you would like to enter an inverter that can be switched to various voltage levels, you must enter the 

different voltage ranges as separate inverters with respective parameters. 

Manufacturer 

Manufacturer and type may not exceed a length of 255 characters. 

DC Power Rating [kW] 

DC stands for direct current and refers to the input side of the inverter. The nominal output is the output 

specified for the inverter when in continuous operation. 

In continuous operation, the inverter power output is top-limited by the DC power rating and the 

corresponding efficiency. For this reason, the efficiency of the inverter is reduced with higher input power. 

AC Power Rating [kW] 

AC stands for alternating current and refers to the output side of the inverter. The AC nominal output is the 

output specified for the inverter when in continuous operation. In continuous operation, the inverter output 

power is top-limited by the AC power rating. 

For reactive power enabled inverters (AC output [kVA]), the output is given as the magnitude of the apparent 

power. The maximum AC active power (the actual PV generator energy AC) depends on AC output and the set 

displacement factor cos ϕ. 

Max. DC Power [kW] 

Inverter and PV power must be aligned with one another. If the DC power is greater than the power rating of 

the inverter, the inverter may shut down. The maximum PV power is the maximum DC output the inverter can 

convert. In the program, this value is not required to calculate the simulation but only to check the system. 

Stand-by Consumption [W] 

If the inverter does not supply energy to the grid or appliances, the inverter's own power consumption must 

be taken into consideration. In addition to stand-by consumption, there is also night consumption. 
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Night Consumption [W] 

The inverter turns itself off at night, but still requires a minimum level of energy. 

Feed-in from [W] 

There is a minimum output which has to be supplied by the input side (PV generator) before the inverter can 

operate. 

Max. Input Voltage [V]/Max. Input Current [A] 

This voltage or current threshold may not be exceeded. If it is, the inverter will be destroyed. In the program, 

this value is not required to calculate the simulation but only to check the system. 

Nominal DC Voltage [V]/Nominal DC Current [A] 

The inverter input voltage or current, when the inverter supplies the nominal output. 

Number of MPP Trackers 

The number of independent MPP controllers. With multi-string units, this value is greater than 1. 

Max. Recommended PV Output per MPP Tracker [kW] 

See Max. Recommended PV Output [kW] 

max. input current per mpp tracker [a] 

This current threshold per MPP tracker may not be exceeded. (only active when number of MPP trackers >1) 

Upper and Lower Voltage Thresholds for MPP Range [V] 

The inverter can control the MPP tracking within this voltage range. This means that the inverter searches for 

the optimum voltage for the PV array within this voltage range, so that the array produces the maximum 

power output. 

Change in Efficiency if Input Voltage Differs from Nominal Voltage 

The inverter efficiency characteristic curve is given for the nominal voltage. If the inverter is not operated at 

the nominal voltage, the inverter efficiency changes. Whether the efficiency curve goes up or down depends 

on whether or not the inverter has a transformer. As a rule of thumb, the following applies: 

The efficiency of an inverter with a transformer decreases with increasing input voltage by about 1% per 100 

V. 

The efficiency of an inverter without transformer increases with increasing input voltage by about 1% per 100 

V. 

Efficiency Characteristic Curve 

The conversion efficiency is the ratio between the output power and the input power, and is dependent on 

the current output of the inverter. 

On data sheets, the figure for the efficiency is related to the nominal output, although, for most of the year, 

this is not supplied by the PV system. The part-load operation is therefore very important for the simulation 

results. 

To determine the characteristic curve, the program requires 7 checkpoints, i.e. the efficiency at 0, 5, 10, 20, 

30, 50, and 100% of the nominal output. 
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10 Cables  

On the Cables page, you can enter cable lengths and cross sections and let the program calculate the 

resulting total loss from the array output (under STCs). The mains voltage used to calculate line losses can 

be modified by clicking the Mains Voltage link (top-right of dialog). The standard values saved here can be 

changed.  

Tree (left-hand side) 

A tree on the left-hand side structures the entry of cable data. The tree groups the cables with the defined 

inverters in the system configuration. The cable values of an inverter can be copied with the toolbar button 

and added to another inverter. 

Entry area for inverter cable values (right-hand side) 

The Mains voltage link can be found in the inverter and electricity meter schematic. Here, you can enter the 

voltage of the supply network to which the system is to be connected. The mains voltage can be saved as a 

default, and is then available every time a new project is created. 

The entry area is divided into String cable, DC main cable (direct current) and AC cable (alternating current). 

The string and DC cabling are entered per MPP tracker. The Cable Cross Section can be calculated with a 

suggested value (click < 1% leakage). The suggested values come from the smallest possible cable cross 

sections which ensure a voltage drop of less than 1 % in the respective cable section. 

The Cable length is entered as total length, which means that the out and in lengths can be different, as is 

typical in some types of cable laying. The cable loss per cable section and for the inverter is then displayed. 

The AC side of the cable length is entered as one way cable length. 

Information 

In the Information area, the total loss for the system configuration is displayed as output and as 

proportional share. In a pre-planning phase, it is possible to enter the total loss directly by activating the 

option Enter total loss. 

By clicking the button Overview of all cables, a table is shown in which the cable lengths with the same 

cross section are added together. 
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11 Financial Analysis 

Page Financial Analysis 

-> To enter the parameters for cost calculation: 

1. Click on Edit. The Financial Analysis Assistant will open. 

- Enter the necessary parameters on all pages.  

  -> For more details, see:  Parameters for Financial Analysis 

- Close the dialog and return to the Financial Analysis page. 

2. Select a Feed-in Tariff. 

3. (For systems with surplus feed:) Select a From Grid Tariff.   

-> see also: 

11.1 For changing the feed-in of the system, see chapter 6.2 AC Grid 
Page Type of System and Environment > AC Mains 

The properties of the AC network are also set here. These are: 

4. The Mains Voltage: in 1- or 3-phase networks; typically 230 V. 

In the case of two-phase systems with 120V, a split-phase topology is assumed, i.e., the two 

phases, L1 and L2 are phase shifted by 180 degrees between each other and so have 240V voltage 

difference. As a result, both 120V and 240V devices (appliances, extra generators and inverters) can 

be connected. 

5. The number of phases that make up the AC mains. Small systems are generally operated on a single 

phase, and larger systems on three-phases. In North America, two-phase topologies (including split 

phase or single-phase three-wire type networks) are also used. 

The standard values saved here can be changed. The mains voltage can be stored as a default so that it 

always has this value in newly created projects. 

• Type of System 

• For U.S. locations, refer to chapter 11.5 Feed-in Tariff 

• Page Financial Analysis > Select Feed-in Tariff > Feed-in Tariff 

You can also define the feed-in tariff via the menu Databases > Feed-in Tariff or via the page Financial 

Analysis > (Feed-in tariffs) Selection > Edit. 

-> The data for a feed-in tariff is: 

Country, Location: Scope 

Type of Installation: e.g. Roof integrated  or mounted - open space 

Name: e.g. EEG 2012 

Valid from: Start of the subsidy 

Payout duration: The power companies supplement PV current for a set period of time and afterward usually 

only pay the statutory minimum remuneration. 

Power Thresholds: The resulting To Grid Tariff is calculated differently depending on the selection made. 
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   Tariff Zones  

In the case of tariff zones, the payment received for Grid Supply changes nearly constantly. 

The payment received for Grid Supply is averaged across all power ranges up to the installed PV output. 

Example: 

From 0-30 kW: € 1 

Starting at 30 kW € 0.5 

A system capacity of 50 kW results in a Grid Supply payment of 30/50*€ 1 + 20/50*€; 0.50, or in other 

words € 0.8. 

   Tariff Bands:  

In the case of tariff bands, there is a sudden change in the payment received for Grid Supply if a power 

limit is exceeded. 

The feed-in tariff is directly calculated based on the installed output. In the example above, the payment 

received for Grid Supply for all power would be € 0.50. 

Feed-in Remuneration: in €/kWh (or $/kWh) for different power levels in kWh 

Own use Remuneration: Remuneration in €/kWh (or $/kWh) from specified percentage or power in kWh. 

Basic Feed-in Payment: Here you can define the To Grid Tariff that will apply after the payout duration. 

11.2  

11.3 *Note: The currency (here: €) is taken from the settings of your computer. 
From Grid Tariff 

Page Financial Analysis > From Grid Tariff Selection > From Grid Tariff 

To define the From Grid Tariff, go to the menu Database > From Grid Tariff  or the page Financial Analysis > 

(Grid Tariff) Select > Edit. 

-> Requirement: 

There are grid tariffs only for the following system types "grid-connected PV system with electrical 

devices (so-called "captive") and surplus supply" 

-> The data for the feed-in tariff are: 

Country, Location: Scope 

Energy supplier: selected company, abbreviation: EVU 

Name: Tariff  name, e.g. Berlin basic private current 

Consumption type:     Private or     commercial 

Base price: consumer-independent portion of price per month 

Energy Price: consumer-dependent portion of price per kWh 

• Financial Analysis using WebService 
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11.4 Edit Financial Analysis Parameter 

Page Financial Analysis > (Financial Analysis Parameters)  Edit 

Move through the Financial Analysis by using the Continue and Back buttons at the bottom of the window or 

by using the left-hand Navigation Bar to jump straight to the required page. 

Every window contains a Help button (in the bottom right corner) which gives help in respect of the required 

entry parameters. 

11.4.1 Basic Parameters 

Page Financial Analysis > (Financial Analysis Parameters)  Edit > Basic Parameters 

Assessment Period: 

Only complete years, not including the year in which the system starts operation, should be entered for the 

Assessment Period. 

According to German standard VDI 6025, the Assessment Period is the time period of planning base for the 

calculation of financial analysis (planning horizon). 

The Assessment Period should be based on the investment with the shortest Service Life. 

If the Service Life of an investment is less than the Assessment Period, the investment will have to be 

repurchased.  

If the Service Life of an investment is greater than the Assessment Period, the investment will have a 

residual value at the end of the Assessment Period, which is included in the capital value calculation.  

Interest on Capital: 

The Interest on Capital can be entered as the Internal Rate of Return. The Internal Rate of Return is the 

average yield from fixed interest bonds. The German Federal Bank determines this from the average yields 

on outstanding debt securities. The Rotating Net Yield is therefore a measure of the interest level on the 

bond market. 

Sales Tax 

This entry field does not influence the calculation, but is there to make clear that all amounts should be 

entered either with or without sales tax. As a rule, all amounts should be entered as net sums. However, if 

you enter a gross amount, you should make sure that all entries are gross. 

11.4.2 Income and Expenditure 

Page Financial Analysis > (Financial Analysis Parameters)  Edit >  

Tax deductible Outgoing cost of system setup parts and labor  

are the total acquisition costs (net) for the PV system (materials, structure, installation, data logger) that are 

required to build the plant.  

Enter the absolute (€) or specific (€ / kWp) amount.  

Subsidies and annual operating costs  

can be stated as absolute amounts in  €, as a specific amount in proportion to overall output, or as a 

percentage of the investment.    

The feed-in remuneration for the first year  

is calculated based on the Feed-in Tariff and the amount determined in the simulation.    
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*Note: The currency (here: €) is taken from the settings of your computer. 

 

11.4.3 Financing 

Reference 

Here you can give the loan a name, which will then appear in the Project Report.   

Loan Capital 

The amount of credit, with the calculation based on interest and repayment. The loan amount can be entered 

as an absolute figure in euros or as a percentage of the investment volume. Investment Volume is 

understood here as the investments plus one-off payments less subsidies. 

Payment Installment as a percentage of the loan capital (Discount) 

This value specifies which percentage amount of the loan capital entered is actually paid. The loan amount 

paid is based on the loan capital multiplied by the disbursement rate. 

The Total Disbursements 

for all loans should not be greater than the Investment Volume defined above. You will also need to define 

whether the loan is an Installment Loan or an Annuity Loan. 

Installment Loan 

With this kind of loan, repayments are made in equal installments. The amount of interest to be paid is 

recalculated after each installment from the remaining amount of debt. The total repayment amount is 

calculated from repayments which remain constant and interest on an amount which reduces over the 

period. 

Annuity Loan 

With this kind of loan, repayments are made in equal installments over the repayment period. The loan 

repayment amount as a percentage of the installment increases with the number of installments, while the 

interest percentage sinks correspondingly. 

Period 

The loan-repayment period 

Loan Interest 

Nominal Interest Rate to be paid on the remaining debt 

Repayment-Free Initial Years 

During this period no repayments, but only interest payments are made. In the remaining time up to the end 

of the period, the loan capital is repaid in installments. 

Repayment Interval 

Interest and installments are paid at these intervals. 
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11.5 Feed-in Tariff 
Page Financial Analysis > Select Feed-in Tariff > Feed-in Tariff 

You can also define the feed-in tariff via the menu Databases > Feed-in Tariff or via the page Financial 

Analysis > (Feed-in tariffs) Selection > Edit. 

-> The data for a feed-in tariff is: 

Country, Location: Scope 

Type of Installation: e.g. Roof integrated  or mounted - open space 

Name: e.g. EEG 2012 

Valid from: Start of the subsidy 

Payout duration: The power companies supplement PV current for a set period of time and afterward usually 

only pay the statutory minimum remuneration. 

Power Thresholds: The resulting To Grid Tariff is calculated differently depending on the selection made. 

   Tariff Zones  

In the case of tariff zones, the payment received for Grid Supply changes nearly constantly. 

The payment received for Grid Supply is averaged across all power ranges up to the installed PV output. 

Example: 

From 0-30 kW: € 1 

Starting at 30 kW € 0.5 

A system capacity of 50 kW results in a Grid Supply payment of 30/50*€ 1 + 20/50*€; 0.50, or in other 

words € 0.8. 

   Tariff Bands:  

In the case of tariff bands, there is a sudden change in the payment received for Grid Supply if a power 

limit is exceeded. 

The feed-in tariff is directly calculated based on the installed output. In the example above, the payment 

received for Grid Supply for all power would be € 0.50. 

Feed-in Remuneration: in €/kWh (or $/kWh) for different power levels in kWh 

Own use Remuneration: Remuneration in €/kWh (or $/kWh) from specified percentage or power in kWh. 

Basic Feed-in Payment: Here you can define the To Grid Tariff that will apply after the payout duration. 

 

*Note: The currency (here: €) is taken from the settings of your computer. 

11.6 From Grid Tariff 
Page Financial Analysis > From Grid Tariff Selection > From Grid Tariff 

To define the From Grid Tariff, go to the menu Database > From Grid Tariff  or the page Financial Analysis > 

(Grid Tariff) Select > Edit. 

-> Requirement: 

There are grid tariffs only for the following system types "grid-connected PV system with electrical 

devices (so-called "captive") and surplus supply" 
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-> The data for the feed-in tariff are: 

Country, Location: Scope 

Energy supplier: selected company, abbreviation: EVU 

Name: Tariff  name, e.g. Berlin basic private current 

Consumption type:     Private or     commercial 

Base price: consumer-independent portion of price per month 

Energy Price: consumer-dependent portion of price per kWh 

11.7 Financial Analysis using WebService  
Page Financial Analysis 

Here, you enter data related to the profitability of the solar system.  

-> Prerequisites: 

1. On page   Project Data select Country = UNITED STATES 

2. On page System Type and Environment select Climate Data location in the U.S.. 

! Don't forget to adapt the AC Mains setting! 

3. On page System Type and Environment select Type of System = "Grid Connected PV System 

 Web-based calculation of subsidy and financial analysis" 

4. Go to page   Financial Analysis.   

-> Proceed as follows: 

5. It is important to set the type of project, since various utility rates and tax groups are available 

depending on whether  residential or commercial is selected here. 

System costs 

6. The costs of the system on acquisition and over its lifetime are entered under costs of the entire 

system. Here, you should enter the sales prices exclusive of any subsidies or tax breaks. 

7. If the system is financed by a loan, deselect the No Loan option and click the Loan button. 

The loan information  dialog opens. 

Choose from the following options in the type of credit selection box: 

o Secured loan 

o Unsecured loan 

o New Home loan 

o Refinancing 

Use the radio buttons to select entry of either the down payment amount or the amount of finance as 

a percentage. Enter the term of the loan in years and the interest in percent. Confirm your entries by 

clicking OK. 

8. On returning to the main window, enter the operations and maintenance costs and the expected 

assessment period. 

9. Enter the relevant amount of inverter replacement costs. 
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10. In the field Replace after, enter the period of time in years after which replacing the inverter will 

typically be required. 

Consumption 

11. Under Consumption, select the Utilites supplier and the Utility Rate. The options available are 

determined by using the type of project on top of this page (Financial Analysis) and on the basis of 

the ZIP code entered on the page Project Data for the system location.  If you modify those entries, 

you must reselect Utility and Utility Rate. 

12. Choose annual electricity costs and enter them.   

13. Or choose   monthly consumption. 

- Click the Entry button, a dialog opens. 

- Enter the  electricity consumption data for each month individually. 

- Confirm your entries by clicking OK. 

In addition, you can enter an expected annual increase in energy costs as a percentage. 

14. If you do not know your electricity consumption, you can calculate it via the web service by clicking 

the link estimate consumption with Home Energy Saver. The web site http://hes.lbl.gov/consumer/ 

opens in your internet browser. The option is only available if you have a connection to the internet. 

15. Enter the annual energy cost increase in %. 

Entries for selecting subsidies and incentive programs 

16. Enter the annual income 

17. Enter the tax class of the solar system purchaser for the range of subsidies and incentive programs. 

In the selection box  , choose from the following: 

o Single 

o Married with joint tax return 

o Married with separate tax returns 

o Head of family 

18. In some areas, there are subsidies which exclude the take-up of others. To account for this, activate 

the checkbox choose optional subsidy, if offered. 

 not checked -> You'll automatically get the first subsidy offered. 

 checked -> You'll automatically get the second subsidy offered. 

The selected subsidy is shown in the presentation under Cost Breakdown > Gross Installed System 

Cost > Incentives received by the Installer. 

19. Optionally, activate the   accept SREC prices checkbox. 

20. Clicking the Entry button, the data for Renewable Energy Credit dialog opens. Here, you can enter 

and select the following information: 

o Amount of SREC per kWh 

o Term in years 

o SREC increase in percent per year 

o and the SREC can be taxed option 

21. Confirm your entries by clicking OK. 
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Note: Some subsidies in California require installation exclusively with products certified according 

to “SB1 Guidelines”. Please bear this in mind when selecting your PV modules or inverters. Check the 

web site http://www.gosolarcalifornia.org/equipment/pv_modules.php for a list of eligible SB1 

Guidelines compliant photovoltaic modules. 
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12 Simulation    

Page Simulation 

This page shows the simulation results. 

-> Proceed as follows: 

1. Go to the   Simulation page to begin the calculation.  

The simulation calculation displays a progress bar and day 

display.  

Each year is calculated from 1/1 00:00 to 31/12 24:00. 

o Supply to the grid by the PV system in kWh/year 

o Specific annual yield in kWh/(kWp*year) 

o Performance Ratio 

o Yield prognosis for the system: The diagram shows the PV generator energy that has been fed 

into the grid throughout the year.  

->  See also: Chapter 14 Glossary 

2. Some results are displayed on this page.  

3. The complete results can be found on the Results page. 

  



Manual PV*SOL basic 6.0 

Dr. Valentin EnergieSoftware GmbH  70 / 82 

13 Results 

Page Results 

This page shows the results of yield simulation and the economic analysis. It also creates the client 

presentation. 

 

Results 

Click on a  Results table or a   diagram in the tree registry in order to display the results in the window 

on the right: 

 Simulation:  

- PV system: PV generator power, PV generator energy (AC grid), Spec. annual yield, Energy to the grid, 

Performance ratio 

- for a system with excess supply:  Consumers:  Consumption, Energy drawn from the grid, Solar 

fraction, Proportion for own use 

Earnings forecast (with consumption) 

Radiation: Radiation on the horizontally oriented or  the angled surface 

External Temperature 

 Economic efficiency: 

-  Return on investments, period of amortization, accrued cash flow (cash balance), electricity generation 

costs (not for U.S.A. and web-based determination, see System Type) 

Accrued Cash Flow (Cash Balance) 

Current cost trends over the analysis period (only for U.S.A. and web-based determination, see 

System Type) 

The individual results are explained in the Glossary. 

View Presentation 

• Click on Display to display thePresentation. 

• Click on Configuration to determine the content of your presentation:  

o View Title Page The title page contains your address information and your company logo 

customer data and a project description and illustration. 

o Project Overview 
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o Show System Structure: This page shows the main benchmark figures of the PV system the 

primary yield results and the financial analysis. If a preview was generated with Photo Plan the 

resulting image is inserted here  

o View Roof Plan: This page contains an illustration of the roof plan displaying the blocked- off 

areas and the position of the module surfaces you have created. 

o Results 

o View Inverter Datasheet: All manufacturer data on the inverters used are listed in a table. 

o View PV Module Datasheet: All manufacturer data on the PV module used are listed in a table. 

o Financial Analysis: The most important inputs and results concerning economic efficiency are 

presented:  

- Electricity costs before and after solar installation,  

- Annual savings  

- Proposal for an electricity tariff 

- Diagram: cash flow and electricity costs  

-Statement of cash flows for each year of the assessment period 

- Expected payments in the first year, including subsidies and tax exemptions. 

You can save the configuration of the project report as a default so that it will be available for other projects. 

13.1 View Presentation 

Page Results >(View Presentation) Show 

The presentation contains the most important information for a customer offer.  

The page is displayed as a thumbnail on the left and full sized on the right. 

Menu and toolbar provide the usual features:  

• Go to, Zoom, Full Screen, Print Page, Print All, Fax, Save As, Send, Full-text Search 

• You can select  save in file formats via the menu File > Save as > File type:  

   pdf, tif, txt, emf, jpg, png, xps. 

• The following menu is also  available File > Save asr > Save as RTF. 

  

View, pdf Export and Print in Preview Editor 

Page Results >(View Presentation) Show > File > Save as 

Via the navigation bar, you can navigate through the presentation, enlarge or reduce the view, and start an 

on-screen presentation. 

You can print the current page or the entire presentation. 

You can launch the Save as dialog or send the preview in a selected format by mail. These functions are 

available in the Menu under Save as RTF. The following export formats are supported: .pdf, .rtf, .tif, .txt, 

.emf, .xps und .ll 
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13.2 Graph Window 
The graphics have their own menu, a toolbar, and various context menus which can be accessed by clicking 

the right mouse button. The symbols and the context menus are dependent on the selected object. Objects 

are the separate curves, the two axes, and the legend and title bar. 

You can change the graphics display to suit your needs. A detailed description can be found in the following 

chapters. 

A number of formatting features for the selected part of the graphics output (data record, axes) can be 

quickly modified with the help of the graphic symbols: 

Graphics Toolbar 

   
Click on the red arrow symbol to display the next or preceding time period (only if the 

display interval is smaller than a year). 

 

Increases and reduces the type size of the selected object (axes, title, legend). 

 

Toggles between normal and bold type for the selected object (axes, curve, title, 

legend). 

 

Change font for all objects. 

 

The selected curve toggles between line and bar display. 

 

The draw area is rastered in accordance with the selected axis. 

 

The values can be copied into other programs via the clipboard and, for example, 

edited in Excel. 

 

Send graphic to printer. 

  

Display Period 
Graphics menu Display 

Under Display, you can use Time Axes to define the period to be displayed over the time axis. You can 

choose from day, week, month, and year. A display of other periods (for example two months) can be 

selected under Axes / Format X-Axis. 

Options 
Graphics menu Options 

Legend: here, you can choose whether or not to display the legend. 

Title: here, you can choose whether or not to display the diagram title. 

Graphics: Print 

The usual Windows Printer Settings dialog appears. Here, you can select a printer and its settings. 
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Title 
Graphics menu Curves > Title or context menu 

If you click the rectangular border in the graphics area, a dialog window opens in which you can give the 

graph a new title. After closing the dialog window, this title is displayed in the graphics output. Using the 

mouse, you can now move the title to any position within the graph area. 

Curves 
Graphics menu Curves or context menu 

In the Curves graphics menu, all selected data records are listed and can be formatted. The currently 

selected formatting is marked with a check by the menu item. 

The individually displayed data records and the Y- and X-axes can also be selected in the graph by simply 

clicking the left mouse button on them. The selection is made clear by dots on the graph. With curves and 

the X-axis, you must alway click below the line to select, with the Y-axis left of the axis! 

If several Y-axes are displayed, the curve color of the curve it represents is shown below each Y-axis, making 

coordination simpler. 

Double-click on the X- and Y-axis to open the Format X-Axis and Format Y-Axis dialogs. 

A click with the right mouse button opens a context menu for the axes and curves with menu items for the 

current object. 

The scaling of the axes and the position of the coordinates can be freely changed. Display interval of 1 day to 

1 year. All axes and axis designations can be formatted and moved. 

Own Y-axis: Allocate a further Y-axis for the selected data record. A dialog for scaling the new axis opens. 

By selecting the relevant options, the curve can be presented in bold or normal type, as a line or bars. 

Use Change Color to give the curve a different color. 

Invisible: By selecting this, the selected curve is not drawn. The curve is not deleted but can be made visible 

again by selecting this option once more. At least one curve must be visible at all times. 

You can also access this submenu by selecting the desired curve and clicking the right mouse button or via 

the symbol buttons. 

X-Axis 
Graphics menu Axes > X-Axis or context menu 

The period of time to be displayed on a diagram and over which the values of the data record should be 

totaled or averaged is defined in this dialog window. 

Different dialogs appear here depending on whether the graph shows a representation over time or not. 

 

Image : Scaling the X-axis (daily display) 
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• Column width: The display period for which the data is to be summarized is defined under column 

width. Depending on the unit you have chosen, the values of the data record are either totaled 

(energy) or averaged (output, temperatures) here. 

• Display from: This is where the time point in the year at which the display of data records should 

begin (in date format) is entered. 

• Display interval: The period of time over which the graph should be displayed is defined under 

Display Interval. In addition to the time interval, with the choice of day, week, month, and year, the 

rate and designation of the main interval of the X-axis is also set. 

Y-Axis 
Graphics menu Axes > Y-Axis or context menu 

 

Image : Input field for formatting Y-axis 

Access the dialogs for scaling the axes via the Axes graphics menu, by double-clicking the axis, or via the 

Scaling menu which can be opened with the right mouse button when the axis is selected. 

The selected Y-axis is formatted in this dialog window. 

Unit: here, select the unit in which the Y-axis and its associated curves are to be displayed. If you select the 

Position on Right box, the Y-axis is positioned on the right-hand side of the diagram. 

Position of X-axis: this is where you define the intersection point of the X-axis and Y-axis. If you select 

Minimum, the X-axis is drawn at the bottom edge of the Y-axis. On the other hand, if you select Maximum, 

the X-axis is drawn at the top of the Y-axis. If you want to freely define the position of the X-axis, enter the 

desired Y-value in the Cross X-Axis At field. 

Scaling automatic: if this field is selected, the axis is scaled independently of the entries below using the 

minimum and maximum values of the Y-axis curves. If the X-axis display interval is changed, the scaling is 

updated. 

If the following scaling values are modified, automatic scaling is immediately deactivated. If this is the case, 

the entered scaling applies to all display intervals of the X-axis. This is especially useful for quick 

comparison of different display intervals. 

Min. Value: the minimum value to be displayed is entered in the currently selected unit. 

Max. Value: the maximum value to be displayed is entered in the currently selected unit. 

Main Interval: definition of the labeled intervals. The interval is entered in the currently selected unit. 

Sub-Interval: definition of subdivision of main intervals. The interval is entered in the currently selected unit. 
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Grid Lines: dotted or continuous lines are drawn at the level of the main interval. 

Legend 
Graphics menu Curves > Legend or context menu 

All the displayed data records are assigned to their respective representation in the legend. 

If energy is displayed, the sum of energy in the presented period of time is shown after the respective data 

record name. 

If power, temperatures, wind speed, and evaluation parameters (fraction, efficiency) are displayed, the 

average values are shown in the presented period. 

The legend field can be selected and moved. 

Coordinates field 

The bottom bar of the graphics output contains a field with the current coordinates when the cursor is within 

the diagram. The date and time as well as the associated X-value of the cursor position are displayed. 
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14 Glossary 

Accrued Cash Flow (Cash Balance) 

Total cash flow after tax 

Amortization Period  

Period of time in which the capital value of the investment is positive for the first time 

Consumption 

-> see : Power Consumption 

Displacement Power Factor (cos φϕ) 

On the basis of the EEG Amendment of 2012 to maintain network stability, in order to ensure the reactive 

power balance between power and consumers, PV system operators must provide reactive power.  

e.g.: Network operators charge cos (ϕφ) = 0.9  ->  The inverter must deliver 10% greater performance: 90% for 

the current active power + 10% for the new reactive power  

In addition, the network operator must be possible to remote control large PV systems with > 30 KW. 

Small PV systems with < 30 kW must be limitable to 70 %. 

-> see: Reactive Power 

Electricity Production Costs 

The Electricity Production Costs are calculated from the annual costs divided by the amount of electricity 

produced. 

The annual costs result of: 

• Present value of annual costs, 

• One-off Payments, 

• Loan Payments 

• Self-funding multiplied by the Annuity Factor. 

Energy Produced by Back-up Generator 

Energy from the auxiliary or additional generator 

Energy from Grid 

Annual current drawn from the AC Grid.  

Energy yield, yield forecasting 

Annual energy yield describes the solar energy fed into a (public) electricity grid. 

-> see also: Specific Annual Yield 

-> see also: PV Array – Generated Energy 

External Temperature 

The external temperature is a specification taken from the climate data files. It is required to define the 

module temperature, as the module efficiency is dependent on the temperature (see PV Module 

parameters). 

Grid Feed- in 

The energy generated on the AC side of the PV array is the energy produced by the invertor and fed into the 

network. Corresponds to the PV array generator power (AC Grid), minus own consumption. 
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Incident Angle Modifier [%] IAM 

The incident angle modifier is a characteristic of the material covering the module (glass). The angle to 

measure the IAM is 50° (between the ray and an orthohonal of the module surface (40° between panel and 

ray)). The glass reflects part of the radiation away from the module resulting in a loss of current. The incident 

angle modifier reduces the amount of direct radiation falling onto the module. The correction factor for 

diffuse radiation lost through reflection is assumed at 95%. 

Internal Rate of Return 

The yield represents the ratio of payments to the deposit of money or capital investment. Basis of 

calculating the yield of a solar system is the profit that is set in relation to investment. The return on assets 

provides an overview of the return on total investment. The yield is a key indicator for assessing the viability 

of a solar system. 

The Internal Rate of Return is calculated according to the Internal Interest Rate Method. Capital interest is 

increased up to the point at which the Net Present Value of the investment becomes less than zero. 

The result can be interpreted as follows: 

Providing one’s own capital (self-financing) for the investment is as good as investing one’s own capital in a 

bank at the interest rate of the internal rate of return. 

Investments 

The depreciable investment are the total acquisition costs (net) for the PV system (materials, structure, 

installation, data logger) that are required to build the plant.  

Irradiation  

The irradiation onto the tilted Array surface is the energy (after subtraction of shade) on the PV surface that 

is available for conversion. A proportion of this energy is lost through reflection on the module’s surface, 

Maximum system voltage 

This value states the maximum voltage which may be applied to a PV array. Modules may only be configured 

in series to the point at which their maximum system voltage at maximum open circuit voltage (link: see 

configuration thresholds) is reached. The maximum system voltage is taken into consideration in the 

inverter configuration. 

Mounted 

Mounted systems are those with modules installed on a mounting system, either free-standing on the 

ground or on a flat roof 

MPP (Maximum Power Point) 

The output of a module is dependent on the irradiation, temperature, and voltage it is operated at. The 

Maximum Power Point is the point on the current/voltage diagram at which the module produces its 

maximum output. 

MPP Tracker 

The MPP tracker automatically sets the solar array's working point at its maximum. 

NEC Temperatures 

The temperatures of a module are dependent on installation location, ambient temperature and irradiation 

to the modules. This can be entered manually by means of prefabricated standard values entered or based 

on the NEC ® (National Electrical Code ®). If you choose the NEC temperatures, the appropriate 

temperatures are set depending upon the zip code where the system is located. Used for connection limits - 

Configuration Limits of the WR connection 

The Net Present Value is calculated as the sum of: 
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• present value of all Annual Costs 

• present value of all Annual Lodgements and Savings 

• present value of Loan Payments 

• present value of Tax Payments 

• One-off Payments 

• Subsidies 

• Self-Financing 

Open Circuit Voltage 

A module's open circuit voltage UL is usually given by the manufacturer for standard test conditions (STC). 

As the module voltage is also temperature-dependent, maximum open-circuit volatge occurs at low 

temperatures, e.g. -10°, and maximum irradiation. 

Orientation of PV Modules / Azimuth 

The azimuth angle describes the angle of deviation of the module surface from the south. South is defined 

as 0°, east = -90°, south-east = -45°, south-west = 45°, west = 90° etc. 

Parallel operation 

With inverters which allow for parallel operation of the MPP trackers, the MPP trackers can be 

interconnected so that the current and power range are added together. 

Pay-back period 

Period of time in which the capital value (net present value) of the investment first becomes positive 

Performance Ratio  

The Performance Ratio is a measurement of the energy losses that occur within the system in comparison 

with the system's optimal operating conditions. The actual solar energy produced is measured against the 

nominal output. The nominal output is calculated from the irradiation onto the tilted PV surface multiplied by 

the efficiency of the module under standard test conditions (25 °C, 1000 W/m²). 

The Performance Ratio is calculated: PR= (PV Array Energy (AC))/(Max.possible PV Array Energy ) 

Performance ratio = EPVuse / Ein * ηSTC 

The performance ratio is a measure of the energy losses in the system which occur in comparison with the 

energy output of the PV array under standard test conditions. The output under STC is determined by the 

energy irradiated to the PV array surface (Ein) multiplied by the module efficiency under STC (ηSTC).  

The performance ratio describes the efficiency of the photovoltaic energy which can be potentially generated 

in a given system environment. 

-> see also: System Efficiency 

Period of autonomy 

The period in which the batteries can meet consumption without support from the back-up generator. 

Power Consumption 

Only for systems with excess supply: This is the total energy consumption by users per year.  

-> see also: 

• Energy from Grid 

• Consumption 
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Power Consumption, Own  

Own consumption fraction = own consumption /(own consumption + excess supply) = consumption / PV 

array generator power 

-> see also: Solar fraction 

PV Array, Irradiation 

The irradiation onto the tilted PV array surface is the solar energy available without shade. 

PV Array, Generated Energy (AC Side) 

The energy generated on the AC side of the PV array is the energy produced by the inverter and, with full 

feed-in, fed into the network. Module, cabling, and inverter losses are taken into account. It is measured 

between inverter and net, that is why energy and power become negative, if the PV modules don't deliver 

current, but the standby power of the inverter and it's losses have to be made anyway.  

The PV array requires energy for standby and night, this energy is not subtracted here, but displayed 

separately. 

PV Array Output 

The PV array output of a solar array is the maximum output it can produce with vertical irradiation with 1000 

W/m². It is therefore given in Wp or kWp. "p" stands for "peak". 

A maximum of 1000 modules can be calculated. The maximum generator power is: 1000 x power capacity 

Max. PV array generator power = PV module efficiency * radiation on the PV array 

Reactive power 

On the basis of the 2012 EU amendment on maintaining grid stability in order to ensure reactive power 

balance between the grid and appliances, PV system operators must provide reactive power.  

e.g.: Network operator charges cos(ϕφ) = 0.9  ->  The inverter must deliver 10% greater performance: 90% for 

the current active power + 10% for the new reactive power  

In addition, larger PV systems with > 30 kW must be remotely controllable by the grid operators. 

Small PV systems with < 30 kW must be limitable to 70 %. 

Parameters: reactive power Q, Apparent power S, active power P, displacement factor cos (φϕ)  

S = P / cos(ϕφ) 

Q =√(S²-P²).  

Roof-Integrated 

Roof-integrated means that the roof cladding has been partially removed and replaced by the modules 

themselves. 

Roof-parallel 

Roof-parallel means that the modules are mounted a distance above the roof cladding, but are parallel to it. 

-> Synonym: flush-mount 

Short Circuit Current 

A module's short circuit current IK is usually given by the manufacturer for standard test conditions (STC). As 

the module current is also temperature-dependent, the maximum short circuit current occurs at low 

temperatures, e.g. -10°, and maximum irradiation. 

Solar fraction 

The solar fraction states the percentage of the annual energy requirement which can be provided by a solar 

system. 
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solar fraction = own consumption / (own consumption + mains supply) = own consumption / consumption 

-> see also: Power consumption, own 

STC (Standard Test Conditions) 

Standard test conditions were introduced to enable uniform (output) comparisons of modules. They describe 

the general conditions under which the parameters given on the data sheets were determined. These are a 

temperature of 25°C, 1000 W/m² irradiation, and an AM factor of 1.5. (AM, "Air Mass", describes the entrance 

route of the irradiation through the atmosphere and thus the spectral composition of light). 

Specific Annual Yield = EPVuse / Pnom 

The specific annual yield is the usable energy (EPVuse) in relation to the installed output (Pnom). 

Put another way, the specific annual yield is a measure of the PV system's annual full load operation hours. 

The term final yield is frequently found in the literature in place of the specific annual yield. This is 

determined from the annual full load hours divided by 365 days and is a measure of the daily full load 

operation hours.  

Stand-By Energy Consumption 

The inverter requires energy when the PV array doesn't deliver any: This is regarded as night consumption, 

when between 20:00 and 05:00, and otherwise regarded as standby consumption. 

System Efficiency = EPVuse / Ein 

Ratio of energy generated on the AC side (PV system and auxiliary generator) to power consumption for each 

year: 

System efficiency = (consumption) / (maximum possible PV array generator power + back-up generator 

energy) 

-> see Performance Ratio 

Tilt Angle / Inclination 

The tilt angle describes the angle between the modules and the horizontal plane. For facade mounting, the 

tilt angle is 90°. 

Total Investment Costs 

Is the sum of system costs over the assessment period excluding running fuel costs 

Unbalanced Load 

Unbalanced load refers to the uneven load of the outer conductors of a three-phase supply network. 
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